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Introduction 

We are happy to welcome you as a user of the CardioDM-06® software for 
heart screening (hereinafter the screening analyzer). This screening analyzer 
significantly differs from the traditional ECG analyzers because it is based on a new 
approach to ECG signal analysis – the ECG Dispersion Mapping method. The ECG 
DM method uses traditional ECG signals only as the way of capturing low amplitude 
oscillations of body surface potentials. Therefore, the result of ECG signal digital 
processing is not the traditional ECG data, but a map of dispersive changes of the 
myocardium, which is formed on a computer screen as a so called heart portrait. 

The main structural component of the ECG DM method is the dispersion 
analysis of low amplitude ECG signal oscillations during particular PQRST cardio 
cycle intervals. Low amplitude oscillation dispersive analysis is performed during 
30-60 seconds of continuous ECG signal monitoring. The incoming signal is 
provided by limb leads only (electrodes RA, LA, RL, LL). Amplitude dispersion 
medians are in range 5 … 30 microvolt, which is significantly lower than average 
amplitude of ECG waves. Special analysis of such low amplitude signals (ECG 
fluctuation) ensures the reliable identification of small deviations of myocardium 
polarization and repolarization processes. This analysis is related to ECG 
(electrocardiogram) fluctuations with myocardial metabolism changes. Monitoring of 
ECG fluctuations provides indirect conditional assessment of antioxidant systems, 
electrolyte shifts, adenosine triphosphate (ATP) concentration and other parameters 
of metabolism as an integral coefficient of metabolic changes. The change of this 
coefficient allows determining even a minor disorder of myocardial depolarization 
and repolarization processes which are not available in other methods of ECG 
analysis. In ECG DM method of ECG analysis even minor disorders are effective 
indicators of pathological changes of myocardium which are not sufficiently 
significant in conventional ECG characteristics. As a result of such analysis you will 
get a map, showing deviations of low-amplitude characteristics with amplitude of 
such deviations and their presumable location by parts of the heart. To allow a 
physician to have a comprehensive and easily assessed view of the myocardium 
changes, a dispersion map is projected onto the quasi-epicardium of a 3-D digital 
heart model demonstrating the anterior and posterior heart surface. Expression and 
supposed localization of changes are identified according to colour changes of the 
quasi-epicardium, which, if consistently green, is considered normal. 
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Abbreviations  

Abbreviation Meaning 

MCS Medical Computer Systems, Ltd. 

ACG Aorta-coronary grafting 

AH Arterial hypertension 

ECG Electrocardiogramm 

ECG DM Electrocardiogramm Dispersion Mapping method 

HCMP Hypertrophic cardiomyopathy 

HF Heart failure 

HK Hypokinesia 

IHD Ischemic heart-disease 

LBBB Left bundle-branch block 

LVH Left ventricular hypertrophy 

MI Myocardial infarction 

OMICS Old myocardial infarction cardiac sclerosis 

Terminology is based on 

1. “Stedman’s Medical Dictionary”, 2nd edition, published by 
Houghton Mifflin Company Boston – New-York, 2004 

2. Russian-English Medical Dictionary, 3rd edition, published by 
“Russo” Moscow, 1997 
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1. Purpose and usage 
The computer screening analyzer CardioDM-06® (generator of the 

portrait of the heart) allows an instant evaluation of the condition of the heart using 
ECG-signals from the limbs (4 electrodes). 

Why do you need the benefits of the CardioDM-06® screening analyzer? 

• You need a simple and reliable screening unit which even your junior medical 
staff can operate. 

• You have an unending flow of patients, and it is important for you to increase 
the reliability and speed of screening tests. 

• You monitor the patient’s heart during in-patient care, and want to quickly get 
information as early as possible in a noninvasive way on small changes in the 
processes of myocardium electrical activation. At the same time, it is also 
important to you to be able to get this information right where the patient lies 
without moving him/her to the functional diagnostics area 

• You monitor the patient for a long time and want to observe tendencies in the 
changes of heart's state, which cannot be seen on the ECG. 

The screening analyzer can be used: 
• in clinical medicine (instant evaluation of the condition of the heart, early 

detection of progressing changes in the myocardium). 

• in preventative medicine (screening tests for on-time and reliable detection in 
the groups of patients with pre-clinical forms of disorders). 

• in departmental medicine (preventative medical examination). 

• in sanatoriums, preventoriums, rehabilitation centers (objective instant 
indicator of the condition of the heart and the entire body). 

• in emergency medicine for reliable evaluating the current condition of the 
heart. 

• in sports medicine (early and accurate detection of negative dynamics of the 
heart’s state). 

In addition to instant visual analysis of the image, the system forms an 
automatic conclusion for the doctor which includes: 

1. An integral deviation index of the dispersive characteristics of the low-
amplitude ECG variations (index of metabolic changes) from the norm, on a 
scale of 0 to 100%. 
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2. An integral index of rhythm disturbance on a scale of 0 to 100% (a total 
deviation of statistical characteristics of rhythm variability). 

3. A text screening-evaluation. 

 CardioDM-06® quickly and accurately ascribes the heart to one of four 
groups: 

 1. Normal 
 2. Border-line state 
 3. Moderate pathology 
 4. Acute pathology 

At the same time, the doctor gets visual information on the intensity and 
the most probable localization of the center of the changes. In addition, this 
information allows controlling the pre-clinical "near-threshold" changes of the 
state of the heart. 

Exposure time (duration of the ECG data entering) is 30 or 60 sec. The 
portrait of the heart can be obtained without undressing the patient, while he or she is 
sitting up. The time it takes the image to form after the entering of ECG data is 5 to 
20 seconds, and the time it takes to inspect the portrait of the heart from two views 
(from the right and from the left) does not exceed 60 seconds. The portrait of the 
heart is simultaneously formed from two views: from the right side and from the left 
side. In the normal state, the epicardium is green in the image. If there is a center of 
pathological changes in the myocardium, the correspondent area of the heart portrait 
will change its color from green to red according to the degree of the pathology. The 
portrait of the heart gives overall information on dispersion changes in all the cardiac 
chambers and can be easily interpreted by the doctor within 15 to 20 seconds. 
CardioDM-06® gives the doctor the unique ability to observe the tendencies of 
changes in the heart's state by analyzing the image sequence. The time it takes to 
display the gallery of the four consequential images while observing the tendencies is 
30 to 40 seconds. The overall time it takes to obtain the conclusion is 1.5 to 2.5 
minutes. 

The doctor can use the standard view and analysis functions of the ECG data 
from the 6 standard limb leads I … aVF. The screening-test is recorded (conclusion 
report). The screening analyzer has functions which allow for managing the patient 
database and heart portrait database.  
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1.1 Restrictions 

• CardioDM-06® DOES NOT DIAGNOSE! The screening analyzer functions 
to detect early dispersive deviations in the in-between heart group and warn of 
acute pathology. CardioDM-06® screening analyzer is not a distinguishing 
condition of Acute Myocardial Infarction (AMI) among recognizable 
conditions of myocardial ischemia. In such cases the screening analyzer 
shows the probable myocardial ischemia and the need (or urgent need) for 
a clinical examination for diagnosing and rejecting a confirmed diagnosis 
of "acute myocardial infarction". 

• In some cases metabolic changes in valvular diseases and cardiomyopathy are 
indistinguishable from myocardial ischemia by the structure of the dispersion 
map, i.e. the screening analyzer states that myocardial ischemia as a possible 
reason for changes in dispersion. However, such cases can only be found 
during acute pathological changes which, in any case, need a full examination 
with a diagnosis. Therefore, such specificity mistake doesn’t affect high 
screening sensitivity of this screening analyzer in pathological changes of 
myocardium. 

• While analyzing the rhythm, CardioDM-06® DOES NOT DIAGNOSE THE 
TYPE OF ARRHYTHMIA! Only the facts of the existence and acuteness of 
arrhythmia are analyzed, and the most probable type of disorders which are 
connected to the changes in the atriums is determined. The emphasis of the 
analysis is on separating the acute forms of arrhythmia and stress. For this 
reason, some forms of short arrhythmia paroxysms may be undetectable. 
However, even in such cases the portrait of the heart gives the doctor early 
information about the subliminal functional or organic myocardial changes that 
can cause disorders in the heart rhythm. 

• The drug taking can influence on the accuracy of the heart portraits 
visualization and forming the conclusion and comments. If the system is used 
during the drug treatment it is necessary to compare the current data with the 
data collected before the drug taking. 

• The screening analyzer CardioDM-06® is intended for screening-analysis 
of ECG-signal only for adults. CardioDM-06® is not suitable for children 
under 12. This screening analyzer can be used for children and teenagers 
12-18 years of age only for monitoring the tendencies in dispersive 
parameters changes. This resource is determined in each specific case by 
the doctor. 



 

10 

1.2 Principle of analysis 

Amplitudes directly measured on ECG, and indirect parameters calculated on 
the basis of new mathematical model of bio generator of the heart vary within minor 
ranges in successive PQRST-complexes. 

Amplitude and phase characteristics of these variations have a heightened 
sensitivity to the changes in the processes of myocardial depolarization and 
repolarization. It is the dispersion of these variations that is analyzed in CardioDM-
06®. The term “dispersion” corresponds to the generally accepted in cardiology 
determination of the difference between the maximum and the minimum of the 
varying value. Dispersive changes give an integrative estimate of changes in an 
ample quantity of structural characteristics of the myocardium that depend on blood 
parameters, electrolyte balance, blood pressure and similar factors. These dispersive 
changes are observed both in cases of presence of standard electrocardiographic 
changes in the ECG, and in cases of their absence, for example at the early stages of 
myocardial changes. CardioDM-06® allows direct screen observation of the picture 
of the quasi-epicardium changes in the computer heart model that reflects with a 
certain precision both the size and the localization of myocardial changes. The 
information on abnormality of myocardial depolarization-repolarization processes is 
presented in the form of quasi-epicardium color changes on 3D image of the heart – 
heart portrait.  

 Take note of the fundamental methodical peculiarity of the heart portrait 
in the screening analyzer CardioDM-06®. 

Visualization of dispersive characteristics on the heart portrait reflects 
integral changes in morphological, electrophysiological and other such structural 
parameters of the myocardium. As a result the map of color changes in the quasi-
epicardium of the heart portrait of a specific patient has its own stable individual 
peculiarity resulting from personal features of current metabolic changes of 
patient’s myocardium. As a result, the heart portrait is highly specific with respect 
to individual structural characteristics of the myocardium. However, the same 
reason causes the fact that portraits of different patients with the same clinical 
diagnosis may differ substantially in individual characteristics of localization, size 
and degree of the changes. And vice versa: similar changes in the portraits may in 
some cases correspond to different pathologies. The indicated peculiarities in no 
way affect the sensitivity and specificity of the screening assessment, i.e. the 
reliability of the differentiation of norm/abnormality states.  
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2. General information 
The CardioDM-06® is intended for quick identification of heart 

performance abnormalities, which are manifested in the above mentioned dispersive 
characteristics and may be associated with developing heart pathology. 

 The CardioDM-06® DOES NOT DIAGNOSE!  
The function of this screening analyzer is to define earlier dispersive 

deviations which may forego pathology and monitor its dynamics. In many cases 
this allows observation of changes at an early stage, as well as control of the 
dynamics of dispersive deviations with a high level of accuracy. 

The CardioDM-06® IS NOT A SUBSTITUTE for other clinical methods of 
heart diagnostics and MAY be used only under consideration of other clinical data.  

General methods of operating the CardioDM-06® are as follows: 

1. Electrodes are applied in accordance with the standard arrangement of ECG 
limb leads. 

2. The “New Test” button (please see the interface description below) is pressed. 
ECG data acquisition is performed depending on the chosen time exposure of 
30 or 60 seconds. 

3. In about 40 to 70 seconds an portrait of a heart in two projections is formed on 
a screen, together with a general conclusion and integral data indices related to 
a patient’s condition. The quasi-epicardium area of the image is coloured green 
if normal. When various abnormalities are observed, the colours in relevant 
areas change to yellow or red. The larger the red area of a quasi-epicardium, 
the more an abnormality is significant. When dispersive changes are combined 
with large positive ventricular repolarization amplitudes (a peaked ECG T-
wave), a purple shade is added to the red of the corresponding quasi-
epicardium areas. At the same time the more evident deviation from the 
standard occurs, the more changes in quasi-epicardium texture is observed. 

2.1 An ideal heart model 

The CardioDM-06® compares a patient’s dispersion characteristics and the 
dispersion model of ‘an ideal heart’. Such a model corresponds to a heart of a healthy 
young man over the age of 20. If quasi-epicardium performance fully coincides with 
the ideal heart model, it will be displayed in green on the patient’s heart portrait.  

A dispersion map is an indirect indicator of myocardium cell metabolism, 
therefore ‘an ideal heart model’ corresponds to the ‘perfect’ functional state of the 
myocardium, which is characterized by ‘perfect’ metabolism and corresponds to the 
norm. It is obvious that the functional status of a normal (that is, not pathological) 
myocardium may differ from this standard under some specific longitudinal 
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conditions (during pregnancy or during an athlete’s intensive physical training, for 
example). As a result, a certain border-line area, thoroughly controlled by the 
CardioDM-06® screening analyzer, is observed between the ‘perfect myocardium’ 
and an abnormal myocardium. Thus, a physician has an opportunity to identify 
border-line conditions between a norm and an abnormality, that is, there is a 
possibility to observe myocardium changes at early stages preceding disease 
development.  

 

2.2 Visual structure of the heart portrait 

A heart portrait is a ‘snapshot’ displayed on a computer screen as a result of 
computing median dispersion characteristics of low amplitude fluctuations during the 
ECG input. A heart portrait of the ventricular areas reflects the integral picture of 
dispersion changes, involving both ventricular depolarization and repolarization. 
Dispersion changes on a heart portrait of the atrium areas correspond to the 
depolarization phase only. The heart portrait colour changes are observed under 
deviations of amplitude dispersion characteristics as well as under changes of delay 
or acceleration of dispersion characteristics in time (phases of dispersion 
characteristics), which correlate with values of P-Q, Q-T, QRS intervals of ECG 
input signal. The location of amplitude and phase colour indicators on a heart portrait 
is shown in figures: left projection and right projection. Amplitude indicators 
correspond to the anatomical structure of a heart, and the location of phase indicators 
is an approximate projection of relevant depolarization fronts onto the ‘quasi-
epicardium’ of a heart portrait. 

Examples of heart portraits with different states are given in the gallery of 
portraits. 
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Left projection  Right projection  

  

1. precava,  
2. aorta,  
3. integral indicator of rhythm,  
4. indicator of the right atrium myocardial state (depolarization dispersion),  
5. P–Q interval anomalies indicator,  
6. АВ conduction stability indicator,  
7. integral indicator of both atria state (common properties determined by the common 

excitation source),  
8. indicator of the completion phase of the right ventricle depolarization (projection in the 

area of the interventricular septum),  
9. indicator of ventricular repolarization duration (correlates with Q–T),  
10. indicator of the right ventricle myocardial state (repolarization dispersion),  
11. indicator of ventricular depolarization duration (QRS duration),  
12. indicator of the left atrium myocardial state (depolarization dispersion),  
13. indicator of the completion phase of the left ventricle depolarization,  
14. indicator of the left ventricle myocardial state (repolarization dispersion),  
15. indicator of the completion phase of the right ventricle depolarization (projection onto 

the posterior wall).  

2.3 Structure of text messages 

The main function of the screening analyzer is to form the heart portrait 
ensuring the efficient accomplishment of the screening control tasks. The text 
messages that accompany each image are not to be regarded as the diagnosis. Those 
messages give a doctor a screening estimation (4 gradations of deviations), which is 
the body of the conclusion. The screening estimation also furnishes additional 
reference information on the presumptive pathology. The reference information, not 
being the diagnosis, is probabilistic. It helps to make the efficient and task-oriented 
plan for further clinical instrumental examination or other prompt activities on the 
basis of the screening estimation. 

The text messages include three main data groups: 
1. integral indicators 
2. conclusion 
3. detailing 
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2.3.1 Integral indicators 

The integral indicators embrace the following four indices: “Myocardium”, 
“Rhythm”, “Pulse” and “Detailing” 

 
CardioDM-06® screening analyzer integral indicators 

The “Myocardium” and “Rhythm” indicators are relative characteristics, which 
describe the total value of dispersive deviations and range from 0% to 100%. The 
higher the value of the indicator is, the greater the deviation is. Physically, the 
“Myocardium” = 100% corresponds to the pathological complex implying evident 
deviations virtually in all the chambers of the heart. The “Myocardium” = 0% 
corresponds to the total absence of any significant deviations from the ideal heart 
model. 

 The “Myocardium” indicator is the main parameter in the clinical 
interpretation of a screening conclusion. 

less than 15 – no significant deviations have been detected. The changes in 
the myocardial metabolism in the given region are attributable to one’s individual 
peculiarities. This conclusion is to be compared with the other clinical data. 

15% ... 19% – border-line state, dynamics monitoring is advisable. 

20% ... 22% – pathology is likely. If the deviation has been detected for the 
first time, dynamics monitoring is necessary and examination is advisable. 

23% ... 27% – pathology is likely. If the deviation has been detected for the 
first time, dynamics monitoring is necessary and examination is required

More then 27% – pathology or evident pathology. If the deviation has been 
detected for the first time and has been invariably confirmed by successive 
examinations, 

. 

Similarly, the “Rhythm” = 100% corresponds to the most evident changes in 
the R–R intervals variability characteristics, which are inherent to significant 
arrhythmias or intense stresses. 

immediate examination is required. 

The "Detailing" indicator offers information on the similarity of the given 
image to the images of certain typical, widespread pathologies. The “Detailing” 
indicator includes 9 symbols, which can be represented by digits as well as “L” and 
“S” letters. The number of the symbols in the code is equal to the number of the 
pathological groups used by the automatic classifier of the screening analyzer while 
analyzing the fluctuations.  
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The pathological groups include the following: 
• G1: right atrium depolarization 
• G2: left atrium depolarization 
• G3: right ventricle depolarization 
• G4: left ventricle depolarization 
• G5: right ventricle repolarization 
• G6: left ventricle repolarization 
• G7: symmetry of ventricular depolarization 
• G8: intraventricular heart blocks 
• G9: symmetry of leads  

In the G1…G7 groups a wide spectrum of dispersion changes attributable to 
numerous clinical pathologies is analyzed. The names of the groups mainly reflect 
the electrophysiological characteristics of the changes in the atrial and ventricular 
myocardium (depolarization and repolarization processes). In contrast to that, the G8 
group refers to the highly specified dispersion changes, the marked types of which 
correspond to conduction blocks of myocardial electrical excitation. The G9 group is 
showing deviations of wave front of ventricular depolarization. In most cases, such 
deviations correlate to early hypertrophic myocardial changes although in some cases 
they can be determined by the left ventricle ischemia. Despite its rather low 
specificity, the G9 group code is highly sensitive to the change of myocardial 
depolarization rate. The “0” digit in the “Detalization” means that the image 
regarding the given group is within the normal range. The presence of a non-zero 
digit in any of the G1 – G9 groups is to be regarded as the evidence of the similarity 
of the dispersion characteristics of the given image in the group to one of the 
pathologies (here the digit denotes the conventional index of the pathology). The 
higher the digit value is, the more evident the deviation is. The quantity of reference 
pathologies is specific for each group and determined by the following values: G1 – 
17 references, G2 – 10 references, G3 – 16 references, G4 – 22 references, G5 – 3 
references, G6 – 14 references, G7 – 21 references, G8 – 2 references, G9 – 21 
references. The quantity of the references has been chosen so as to ensure the 
possibility to distinguish among approximately 130 enlarged deviation types and to 
form recommendation messages concerning the presumptive pathology. The main 
function of the detailing code is to provide a user with quick-perceptible high-
quality information about the presence of presumptive pathologies with similar 
dispersion characteristics. The presence of a few indices equal to 1 or 2 in the code, 
e.g. “0–0–1–0–1–0–0–0–1”, is evidence of minor dispersive deviations. In contrast to 
that, the presence of high indices equal or similar to the quantity of references in the 
given group, e.g. “0–8–10–19–1–4–20–2–12”, testifies considerable deviations. The 
name of a presumptive pathology corresponding to the index of the conclusion code 
is displayed in the “Detailing” message group (see further). The “L” code refers to a 
border-line state, where the changes have come closely to a pathological gradation. 
The “S” code shows that certain changes have started within the normal range. In 
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other words, the “S” and “L” codes are indicators of border-line values of the 
dispersion characteristics. 

2.3.2 Conclusion  

Conclusion contains a general screening estimate, determined by the 
similarity of the present portrait with pathology portraits. Besides it contains an 
additional information on the manifestation and type of the possible pathology, 
which serves as a recommendation for future decision-making. The screening 
estimate differs from the additional information by colour coding: the screening 
estimate text is coloured, while additional (recommendation) text is black and white. 

 
Positioning of text in the detailed information window. 

2.3.3 Detailing 

Detailing contains the names of probable pathologies, whose portraits for 
each group are the most similar to the given portrait. Moreover, the doctor can see 
some typical quantitative characteristics of waves and intervals of initial ECG in the 
left part of the detailed information window. 

 ATTENTION! 
If you are examining a patient with an electrical cardio stimulator, the 

rhythm deviations information provided by the CardioDM-06® may be false. 
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2.3.4 Report structure 

There are two templates for documenting results in the appliance: complete 
and shortened.  

The Complete ECG protocol contains: 
• standard ECG fragments with the leads I, II, III, aVR, aVL, aVF 
• heart portrait 
• general conclusion text 
• detailed information text 
• doctor’s comments text, input from a keyboard. 

 

Detailed information text and doctor’s comments maybe removed by user 
from the report in the Settings⇒Type of form section of the main menu.  
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The Short ECG protocol contains only ECG fragments and short general 
conclusion.  
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3. Installation of screening analyzer 

Check that the hardware installation has been finished (see chapter 5 of the 
HeartVUE system for non-invasive screening of heart. User’s Guide) and then install 
CardioDM-06 screening analyzer from the Installation CD:  

1. Insert the Installation CD in the CD-ROM and wait till the installation runs 
automatically, or run the Autorun file from the Installation CD. In either 
case the following window appear. 

 

 
 

2. Press the Setup button. 
 
 

3. When the InstallShield 
Wizard’s window appear press 
the Next button. 

 
 

 
 
4. Select English language and press 

the Next button. 
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5. Select the folder for the 

CardioDM-06® screening 
analyzer installation (for 
example C:\Programm 
Files\), or press the Change 
button and appropriate 
folder. Then press the Next 
button. 

 
 

 
 

6. If the folder is right press the Next 
button once more time. 

 
 
 

 
 

7. Press the Finish button when 
the installation is completed. 

 
 
 
 
 

Making of the illegal copy of the distributive is prohibited. The disk is 
copyrighted.  
 

The CardioDM-06® screening analyzer runs only if the USB protection 
key (HASP HL key) is plugged in the free USB socket. The HASP HL key is 
included into the packaging. 
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      ATTENTION! 
The key should be plugged in the computer’s free USB socket ONLY if the 
installation of the CardioDM-06® screening analyzer is finished. After the key is 
plugged and the system defines it the LED will light up (and also the Aladdin HASP Key 
and Aladdin USB Key will appear in the Screening analyzer Manager under the Universal 
Serial Bus controllers). 

 

 
 

If you forget to plug the key in therefore the CardioDM-06® screening 
analyzer won’t run and the error massage will appear. 

 
If you are going to uninstall the CardioDM-06® screening analyze from 

your computer pay attention to the databases’ saving.  
The Windows will ask you to uninstall the CardioDM-06® screening 

analyzer by showing the message CardioDisp: 
Do you want to completely remove the selected application and all of its 

features? 
Select OK if you want to completely remove this screening analyze. 

 
During the screening analyze’s uninstallation the message: 
Attention! Do you want to save the databases before uninstalling the 

CardioDM? 
will appear.  

Press Cancel if you want to uninstall the CardioDM-06® screening 
analyze from your computer without saving the databases. 

Press Next if you want to uninstall the CardioDM-06® screening analyze 
from your computer with the databases are being saved. Then the databases are 
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copied to the TmpCardioDisp\ folder which is located on the disk where the 
CardioDisp screening analyzer’s files were located. 
For example, if the screening analyzer’s files location was  

F:\Program Files\ 
the databases will be saved in the following folder  

F:\ TmpCardioDisp  
At the same time each local database is copied to its own folder 
{YYYYMMDD_hhmmss_n}, where YYYY means – year, MM – month, DD – day, 
hh – hour, mm – minute, ss – second of the database’s creating, n – the identifier of 
the database. 
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4. Operation 

4.1 Program overview 

4.1.1 Start of the program 

You can run CardioDM-06® program by double left mouse click on the 
program icon located on Windows™ desktop. There is also another option to activate 
program: click Start system panel button on the left bottom of screen, enter All 
Programs and CDM-06 section and run CardioDM-06® program.  

 
After running program the main window of the program will appear on 

screen and window showing «List of doctors». 

Main window on the left shows current database of the patient, on the 
right – database of the heart portraits (examination database). 

 
 

The database of the patient has two columns with dates: Date and Original. 
The value from a column Date specifies date of registration of the patient in the 
given database, and the value of a column Original specifies date of the very first 
registration for the imported databases. For example, the patient the first time was 
registered 03.10.2006 in the database DB_01, further on 08.20.2006 his/her data 
were copied in the database DB_02 by means of operations of import / export. In this 
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database the column Date will contain value 08.20.06, and column Original -
 03.10.2006. If a column Original is empty, it means, that the patient was registered 
only in the current database. 

CardioDM-06® program has a list of databases where user can select 
current database necessary for operation. Database can be switched to current 
session through main menu via Settings⇒List of databases. The name of current 
database highlights on headline of main window after the name of doctor.  

You can see main menu line under the headline. While starting database of 
patients (left window) they always arrange by date of registration of patients. The 
examination database (portraits database) of selected patient in a current database 
activates on the right window. Examination database is filtered by date where the 
first record complies the last one by time of registration. Setting of filter is performed 
by function of main menu Filters and includes five filter options (Last day, Last 
week, Last month, All, Interval). The indicator of current setting of a filter is 
located over examination database window. Interval setting options accessed via 
calendar. 

 The list of examinations may be empty if the dates of examinations are 
out of current setting of filter. Therefore you should necessarily select All filtration 
option if you should monitor portraits of a longer period time. In order to avoid 
unsuccessful setting of a filter for current database filtration option is not saved. 
The program automatically initializes All option at every start operation. 

A vertical button panel performing main functions of screening analyzer is 
located on the right side of main window. The buttons arranged in four panels. 
Active buttons are shown by light background (highlight) and inactive by dark 
background. 
4.1.2 Main menu 
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Menu’s folder name Purpose 
File 

Exit to exit program 
Settings 

List of databases to display the list of database 
List of doctors to display the list of doctors 
Type of form to set the form of report 
Color setup to set the indicator’s colours 
Removal of the patient removal of the patient permission 
Enable clipboard clipboard operations permission 

Filters 
Last day to display the examination list for the last day 
Last week to display the examination list for the last week 
Last moth to display the examination list for the last year 
Interval to display the examination list for the period 

time 
All to display all examinations 
Select entire list of 
patients 

to select the all patients 

Selection of all result to select the all examinations  
Recycle 

Clean selected bins to remove examinations from the bin of 
selected patients 

Clean all local bins to remove examinations from all bins 
Import/Export 

from the directory to copy the set of examinations from the 
directory into current or new database. 

from a database to copy the set of examinations from the other 
database into current or new database. 

into the directory to copy the set of examinations from the 
current database to the directory 

into a database to copy the set of examinations from the 
current database to the other database 

into a clipboard 
from the clipboard  

If it is necessary to copy single examination 
from a folder of one patient in a folder another 
one (for example, if the doctor mistakenly has 
written examination in folder of other patient), it 
is possible to copy this examination in clipboard 
(Import/Export⇒into a clipboard), then to 
select an exact folder of the patient and to 
realize in his/her copying from clipboard 
(Import/Export⇒from the clipboard). By the 
default given possibility is disabled. To unblock 
it set up menu option Settings⇒Enable 
clipboard. 
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4.1.3 Button panel 

 

4.1.4 Exit  

To finish operation click menu File⇒ Exit 
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4.2 Examination: formation of heart portrait 

Initially it is necessary to activate patient’s name in database. If patient is 
already registered in database – select appropriate line in patients’ window by left 
mouse click. If patients’ list is big – use Search of patient function in the following 
way. Locate mouse pointer on Search of patient window located on bottom of 
patients’ list and activate this part of menu by left mouse click. Enter any part of a 
name. Indicator on a patients’ list automatically shows you appropriate line. If such 
combination of symbols doesn’t correspond to those in the list of patients – search 
operation is not performed. In such case you should register new patient. For this 

purpose push  button in Patients block of button panel. It is not necessary to fill 
all details of a patient. But it is necessary to enter only surname and push OK button 
in input window. All data of a patient including age, weight and height are used 
only for reference of a doctor. This data has no effect on calculation of 
dispersion mapping. After performing above mentioned actions a line with new 
name appears in database of patients. 

Two characteristics displays in database of patients: QRS angle (direction of 
electrical axis) of last examination and date of patient’s registration in database. If 
you locate mouse pointer on Last name field on headline of window and click left 
mouse – a triangle for alphabet (arrangement by: numbers, letters) arrangement of a 
list will appear. If you click left mouse again the arrangement will be top-down (top 
of triangle down). 

Arrangement by date is performed in the same manner in Date field. While 
entering CardioDM-06® program arrangement always performs by date of patient 
registration. 

Check up size of the established duration of input of an electrocardiogram 

(exposition) which is displayed on button . For switching click the left mouse 
button 

 The basic exposition – 30 sec. An exposition 60 sec is expedient to use 
in the event that you wish to receive more exact value of indicator Rhythm, for 
example, at high stress. Quality of a portrait practically does not depend on an 
exposition. 

Fix the electrodes under the standard scheme of assignments, preliminary 
having greased points of imposing by gel: a red electrode (R) on the right hand, a 
yellow electrode (L) on the left hand, a green electrode (F) on shin of the left leg, a 
black electrode (N) on a shin of the right leg . If application of gel for any reasons is 
undesirable, it can be limited to wetting the point of contact by water. Be convinced, 
that electrodes are fixed without a mistake on the specified color conformity. At a 
weak signal it is desirable to degrease preliminary by skin mix (spirit and ether in the 
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ratio 1:1). Pay special attention on quality of contact of electrode N on which quality 
of an electrocardiogram in other channels R, L, F depends.  

 
Diagram of applying electrodes 

 The major factor guaranteeing accuracy of a portrait is the condition of 
rest of the patient at input of an electrocardiogram. If the patient is in position 
sitting, he/she should accept the convenient weakened position as much as 
possible excluding a muscular tremor. Breath during input of an electrocardiogram 
should be usual, it is desirable without deep breaths or exhalations. If the patient is 
in a condition of nervous excitation, it is possible to recommend to patient to close 
eyes. During input of an electrocardiogram conversation or turns of a head are 
inadmissible.  

Press the left key of the mouse button . If the screening analyzer of 
input of an electrocardiogram is connected to a computer, on the screen of the 
display there will be a window of input of an electrocardiogram-signal and two 
buttons of management of input: Start and Stop. 

If input unit disconnects from the computer, the button  is blocked. In 
this case the computer should be connected to the input screening analyzer of an 
electrocardiogram and the program should be restarted (to leave it and again to make 
active). 

Inform the patient about the beginning of test and necessity to keep a 
condition of rest during 30 (60) seconds, press button Start. The first 5 seconds are 
carried out auxiliary procedures of optimum adaptation of the screening analyzer to 
an input signal. Thus on the indicator of time of an exposition there is a return 
readout: «-5,-4, …, 0». These 5 seconds simultaneously are a pause for a relaxation 
of the patient. Indication of an electrocardiogram begins with readout «0». Input of 
an electrocardiogram-given comes to the end in 35/65 seconds from the moment of 
pressing of button Start (an exposition plus 5 sec.). 



CardioDM-06 software for HeartVUE system 

29 

If during input of an electrocardiogram there will be a necessity to interrupt 
process – press the button Stop. (If after interruption of process by the button Stop 

you wish to return to the main window of system – press button ). 

After end of input of an electrocardiogram there will be an indicator of 
process of generation of a portrait ("sand-glass") on the screen. Through 10 - 40 
seconds (depending on speed of a computer) process will come to the end with a 
display on the screen of a portrait of heart in large-scale portrait. Simultaneously 
with a portrait in the same window integrated indicators and the text conclusion are 
presented. Thus, through 1 min from the moment of pressing of button Start at an 
exposition of 30 seconds the user receives a portrait of heart of the patient. If during 
input of an electrocardiogram there were any noises which have caused sharp 
changes baseline of electrocardiogram, it is expedient to repeat test (remove wrong 
examination in this case from base of examinations). 

 At detection of deviations from norm on the first portraits, to except 
casual influence of artifacts at examination, expediently, not removing electrodes 
to receive one more portrait.  

4.3 Examination: Viewing a heart portrait and text messages. 

Procedure of viewing of output data of program CardioDM-06® is 
expedient for carrying out in the following order: 

• viewing of the portrait 
• viewing of the integrated indicators 
• viewing of the conclusion 
• viewing of the detailed elaboration 

4.3.1 Viewing of the portrait 

On a portrait the slightest changes of dispersive characteristics of electric 
excitation are visible. The picture of changes in color at presence of deviations has 
characteristic individual attributes; therefore a portrait of heart during long time 
keeps these individual attributes (similarly individual attributes of a face of the 
separate person). These individual variations happen significant enough, but all of 
them submit to a uniform principle: 
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 The more intensive red color, and the more the area on which there was 
a change of green color aside red there are more deviations. Usually the most 
significant pathological changes cover left ventricle or at once both ventricle, and 
also area 15 of final phase of depolarization of ventricle on the left projection of a 
portrait of heart. The special attention should be turned on a bright red strip in the 
field of 15 even if all other departments of quasi epicardium have color of norm. In 
case of stable repeatability this attribute correlates with clinically significant 
changes of a myocardium. 

 
Red band in section 15 (final phase of depolarization of the right ventricle),  

correlating with clinically significant changes 

The degree of a saturation of red color in different areas of quasi pericardium 
is not always unequivocally connected with the adverse forecast. For example, at 
some slowly varying conditions of post infarction cardio sclerosis, red color is more 
significant, than at some kinds of a sharp heart attack though the probability of 
relapse of deterioration of a condition in case of cardio-sclerosis, as a rule, is less, 
than at a heart attack of a myocardium. This particular feature of the portrait relates 
with the fact that appearance of dispersive deviations is proportional to total changes 
of myocardium at depolarization and repolarization. At the same time, changes of 
repolarization components of electrical fluctuations at post-infarction may 
significantly prevail over repolarization changes at the earlier stage of myocardial 
infarction Therefore, having seen a portrait, it is necessary to familiarize with the 
conclusion and size of indicators. 

 Please, pay attention: The present guide, despite of high individual 
repeatability color changes on a portrait of heart not always are highly specific for 
pathology of one kind. Changes of dispersive characteristics give integrated 
reaction to changes morphological, electrophysiological, etc. structural parameters 
of a myocardium. Thereof, at the same clinical diagnosis portraits at different 
patients can essentially differ on the area and expressiveness of changes. And on 
the contrary: similar changes on portraits in some cases can correspond to various 
pathologies. These features do not influence reliability screening-estimation, i.e. 
on reliability of differentiation of conditions norm/pathology. 
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There is auxiliary graphical indicator located on the left side from portraits 
where direction of electrical axis of the heart on frontal plane (QRS angle) is 
displayed. Some typical quantitative characteristics of waves and intervals of initial 
ECG as shown in «Detailing» duplicate above this indicator.  

To the procedure of viewing of a heart portrait a new function was added, 
which provides monitoring of probability of electrical instability of a myocardium. 
This function is turned on by setting of an option “Standard” in drop down menu 
“Settings”   of the top menu bar. Besides this function can be launched by the push-
button panel in the right part of the screen. Match the mouse cursor with the button « 
Viewing of one portrait in large scale » and press the right button of the mouse. In an 
appeared window choose the option "Standard" by the left button of the mouse. If 
only the viewing of portraits is necessary, choose the option "Screening". An active 
mode of visualization is displayed by the button «Viewing of one portrait in large 
scale ». If the "Standard" mode is switched on, this button has the following icon: 

. At the "Screening" mode of visualization it looks like  . 

              
 

The additional function "Standard" forms of two additional windows: 
“Micro-alternations of repolarization” and “The indicator of electrical instability”.   
“Micro-alternations of repolarization” window contains an average line of amplitude 
deviation of low-amplitude dispersions on a Т-wave interval of an initial ECG. This 
line called a "TW-alteration" diagram determines a functional dependency of micro 
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alternations amplitude on repolarization time, which corresponds to an average time 
interval from the beginning to ending of a Т-wave. Horizontal scale is synchronized 
with 6 points highlighted with white circles on a line. 

The first three points correspond to time interval of a Т-wave increasing 
from an isoline up to the maximum amplitude. The next three points correspond to 
time interval of decreasing of Т-wave amplitude from the maximum to an isoline. 
Thus, the horizontal axis corresponds to an average duration of a Т-wave, and the 
vertical axis corresponds to micro-alternations amplitude. For a "TW- alternations" 
line the norm border is 11 µV. At considerable deviations the "TW-alternations" 
value can exceed 60 µV. 

The norm border as 11 µV is defined by measurement method of micro- 
alternations amplitude and it is a technological constant for the given device. The 
other methods give values from 3 to 15 µV. To improve visual perception of the 
"TW- alternations" line, values less 11 µV are in green color and values more 11 µV 
are in orange color. The "TW- alternations" line is basic for calculation of the 
average amplitude of micro alternations in “The indicator of electrical instability” 
window. This window gives the extra information about type of changing of  
repolarization micro fluctuations, though for the indicator of electrical instability the 
average value of the "TW- alternations" line is only used. 
 

 
 
The “TW- alternations” window 
 
The window of “The indicator of electrical instability” is the main two-dimensional 
indicator for estimation of probability of electrical instability of a myocardium. The 
vertical axis corresponds to the average amplitude of micro-alternations, calculated 
by line integration in the “TW- alternations” window. The horizontal axis 
corresponds to the variation coefficient of RR-intervals measured during input of an 
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ECG-signal at an examination. Variation coefficient KR is calculated by the formula: 
  KR = (SDNN) *100/M, where SDNN - standard deviation of NN intervals 
(NN – an interval between neighbor R-waves on an ECG); М – the average value of 
NN duration. The current examination value in the viewed window is pointed by the 
four squares pointer 6. All window area is divided on five areas with different colors: 
 
            1 - Minor probability of electrical instability of a myocardium (green color). 
2 - Uncertainty: increased probability of electrical instability of ventricle 
myocardium (yellow color).  
3 - High probability of electrical instability of ventricle myocardium (red color). 
4 - Uncertainty: increased probability of electrical instability of conductive system or 
atrium myocardium (light yellow color). 
5 - High probability of electrical instability of conductive system or atrium 
myocardium (pink color). 
             

The farther pointer 6 is posed from area 1 of green color, the more 
probability of electrical instability of a myocardium. The shift of the cursor to the 
area 3 is connected with increasing of probability of ventricular tachycardia or 
ventricle fibrillation. The shift of the cursor in the area 5 is connected with electrical 
instability of atrium myocardium or myocardium conductive system. 
 

 
 
“The indicator of electrical instability” window 
 
By observing shifts of the pointer by the button 10 “Monitoring of the tendencies”, it 
is possible to reveal on time negative tendencies of increasing of electrical instability 
of heart.                                                                                                               



 

34 

 
The conclusion about probability of electrical instability of heart is displayed in the 
upper part of the window of portrait viewing. 
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 To increase accuracy of this conclusion it is recommended 
dynamics monitoring after small exercise loading to increase pulse on 5 
… 15 % (a simple case is an orthostatic test). By comparing the pointer 
shifts in the tendencies monitoring mode before loading and after, it is 
possible to figure out adaptive resources of heart. 

Window  «Repolarization’s Microfluctuations»   and window  
«Electrical Instability»  are formed on    “TW-ALTERNANS  
VECTOR  REPORT”. 
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To see it click    button, and after “Portrait Viewing” 

window forming click  .  Subject to setting <Type of 
form>  option  “TW-ALTERNANS  VECTOR  REPORT”  
will put in file  *.emf  or print. This report is formed only in     

window  .   Clicking    from other interface 
windows calls only screening form. 

 In lower part of it, as well as in left part of  “Portrait 

Viewing” window  , there is an indicator of  
“Electrophysiological Temperature of Myocardium”.  Its range 
is selected in correspondence with standard thermo dynamical   
temperature of body. This parameter indirectly defines a level 
of functional reserves of myocardium: 

 

Electrophysiological 
Temperature of 
Myocardium  

Equivalent  
Value of 
“Myocardium” 

Levels of   
functional 
reserves of 
myocardium 

36,6 – 36,9   С 

97,9 – 98,4   F 

5 – 14% Physiological 
norm   for current 
heart rate   during 
reading 

37,0 – 38,0   С 15 – 25% Deficiency of   
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98,6 – 100,4 F functional 
reserves of 
myocardium.   

38,1 – 41,0   С 

100,6-105,8  F 

26% – 80% Severe  exhaustion 
of   functional 
reserves of 
myocardium.     

 

Than higher   electrophysiological temperature, the less free 
energy of myocardium and less compensatory capabilities of  
myocardium.  Thus   electrophysiological temperature of 
myocardium is not nosological parameter, but measure of a 
level of adaptive capabilities.  Exactly this property gives this 
index a special status:  independently on nosology it is possible 
to accurately observe    and   predict a dynamics of 
compensatory reactions, which determines, effectiveness of   
current treatment as well as long-term  forecast. 
 
 
 

4.3.2 Viewing of the integrated indicators 

The indicators are located at the top of the portrait window. The main 
indicator is the ‘myocardium’ indicator, which gives a cumulative evaluation of the 
dispersive deviations from the norm on a scale of 0 … 100%. The background colour 
on the indicator informs the doctor about the intensity of any deviations diagnosed in 
accordance with the following chart: 

‘Myocardium’ 
indicator range 

Indicator 
colour Status 

< 15% Green 
No significant deviations. If there are small 
changes of the portrait, these are individual 
peculiarities and a version of the norm.  
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‘Myocardium’ 
indicator range 

Indicator 
colour Status 

15% … 19% Yellow 
Border-line status (transient episode of short-
term increase in dispersive characteristics) or 
early stages of possible pathology.  

20% … 23% Yellow Possible covert pathology.  

24% … 47% Brown Probable pathology.  

> 47% Red Probable significant pathology. 

The ‘Myocardium’ indicator reading can vary within a low range (up to 8%) 
during successive examinations. Indicator variations of more than 8% between 
consecutive examinations which simultaneously change the colour of the heart 
portrait are evidence of myocardial instability and the need to check status with 
increased frequency of examinations (unless these variations are caused by features 
of the ECG, e.g. the electrodes being poorly connected to the skin or a muscle tremor 
while the ECG is being carried out). 

 If the ‘myocardium’ reading is consistently above 19% and other 
inferable information causes you to suspect potential ischemic change, then a full 
clinical diagnosis becomes necessary to differentiate ischemic from non-ischemic 
change. 

Changes of the ‘Rhythm’ indicator are due to arrhythmia or stress, or the 
combined action of both. The background color for this indicator is determined as 
follows:  

‘Rhythm’ indicator 
range 

Indicator 
colour Status 

< 15% Green No significant deviations. 

15% … 50% Yellow Minor deviations.  

51% … 80% Yellow 
Border-line status or moderate 
deviations. 

> 80% Red 
Significant abnormal rhythmic 
deviations. 

The ‘Rhythm’ indicator is a fairly dynamic value, especially during a short, 
30-second, exposure time. Furthermore, this indicator is highly sensitive, even to 
minor disturbances in the resting state while the ECG is being carried out. Its 
readings are guaranteed to be stable only at either extreme of the range. If the patient 
is healthy and the sympathetic and parasympathetic effects on rhythm are perfectly 
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balanced, the ‘rhythm’ indicator will remain consistently in the 0% … 20% range. In 
cases of increased stress or significant arrhythmia, the indicator will be in the >70% 
range. For a healthy city-dweller, the range should vary from 20% … 60%, as a rule, 
and increase towards the evening. If the ‘rhythm’ indicator consistently exceeds 50% 
at any time of day and the patient does not have significant arrhythmia, this is 
evidence of a constant source of heightened tension of the regulatory systems within 
the body (nervous tension, internal organ abnormalities, inflammatory process etc.). 
If heightened ‘rhythm’ indicator readings are simultaneously combined with a 
significant decrease in heart rhythm variability and this combination consistently 
repeats itself, it is a sign of a poor prognosis. If this is the case, the appropriate 
warning appears in the ‘Rhythm’ conclusion section. 

 If you wish to deliberately follow the patient’s stress level while there are 
no significant pathological myocardial changes, we recommend you use the 60-
second exposure. This makes the ‘rhythm’ indicator more stable. 

Change in color of the indicator “Pulse” corresponds to generally accepted 
borders of normocardia, bradycardia and tachycardia for an adult person. The 
bradycardia and tachycardia limits in this screening analyzer do not separate 
sinoatrial rate and clear arrhythmia. A rhythm deviation from the sinoatrial rate is 
indicated by separate, additional messages in the ‘Rhythm’ conclusion section (see 
below). 

The indicator Detailing informs the doctor of pathological deviations similar 

to standard. These can be identified by pressing the  button. Moreover, this can 
be done without having to exit the portrait window. In order to do this, you must 
align the cursor with the Detailing indicator (the cursor will change the pictogram) 
and left-click on the mouse. A bookmark window, entitled “Classification of 
deviations” will appear. The code for each group corresponds to a number in the list 
of generic deviations. 

4.3.3 Viewing of the conclusion  

The conclusion is located under the window with the large portrait and 
contains the following subsections: 

1. GENERAL CONCLUSION – general screening evaluation,  
2. RHYTHM,  
3. ELECTRIC AXIS,  
4. ATRIAL MYOCARIDUM,  
5. VENTRICULAR MYOCARDIUM,  
6. SYMMETRY of LEADS.  

To gain access to all conclusion subsections, scroll down the text as normal 
on the right-hand side of the window. In the case of consistently heightened stress-
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level readings (consistent deviation from the norm in some rhythm variability indices 
with no arrhythmia), a section entitled OTHER CHANGES will appear. The 
concluding text contains the screening evaluation as well as further information on 
the type and intensity of possible pathology to aid further decision-making. The 
screening evaluation can be distinguished from the additional information by a color 
code: the screening evaluation text appears in color whereas the additional 
information is in black and white. There are four distinct levels within the screening 
evaluation: norm, minor deviations from the norm, moderate deviations, and 
significant deviations. The colour of the text will indicate the level of deviation from 
the norm in accordance with the following chart: 

Colour of 
screening 

evaluation text 

Index and designation for level of deviation 
from norm 

Green 
1. Norm (no significant deviation) or on the norm’s 
outer limits  

Light orange 2. Minor deviations from the norm  
Red 3. Moderate deviations 
Red 4. Significant deviations 
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Texts of the screening-assessment on sections of the conclusion include the 
following basic text messages: 

Deviations Gradation 
Index The screening – estimation text  

1. GENERAL CONCLUSION 
1 

(«Myocardium» – <15%) 
NO significant deviations found. Such conclusion may 
be used only for comparison with anamnesis and 
physical parameters. If the patient is taking MEDICINE 
such conclusions necessarily has to be defined more 
precisely based on complete examination and 
monitoring of dynamics by this screening analyzer 

1-2 Little changes WITHIN the NORMAL RANGE: it is 
advisable to check the DYNAMICS for differentiation 
between variant of norm from an initial phase of 
significant deviations. 

1-2 There are small CHANGES in the process of ventricle 
excitation: it is expedient to monitor the DYNAMICS as 
these changes can signal either the onset of significant 
deviations or a sign of temporary functional 
irregularities. 

1-2 Subtle irregularities of the left ventricle function are 
probable. 

2 
("Myocardium" – 

16% ... 19%) 

Moderate CHANGES of the ventricles myocardium. 
Monitoring the DYNAMICS is advisable. 

2 Deteriorations of the left ventricle function are 
probable. 

3 
("Myocardium" – 

20% ... 27%) 

DEVIATIONS – see probable detailed elaboration on 
deviation groups. 

4 
("Myocardium" – >27%) 

SIGNIFICANT DEVIATIONS: pathological changes are 
probable. See probable detailed elaboration on 
deviation groups. 

2. RHYTHM 
1 NORMAL – sinus rhythm. 

1-2* Moderate TACHYCARDIA. 
3-4* SIGNIFICANT TACHYCARDIA. 
1-2* Moderate BRADYCARDIA. 
3-4* SIGNIFICANT BRADYCARDIA. 

3. ELECTRIC AXIS 
1 NORMAL position of the electric axis of the heart 
1 HORIZONTAL position of the electric axis of the heart. 
1 VERTICAL position of the electric axis of the heart. 

2-4 Electric axis deviation to the LEFT 
2-4 Electric axis deviation to the RIGHT  
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The additional information in sections of the conclusion is traced out in 
black-and-white. The additional reports having the high clinical importance, for 
example - messages of probable ischemia, are traced out in contrast black color.  

If the following message is being formed «probable signs of the left ventricle 
abnormality », it means, that there are significant changes of dispersive 
characteristics of the left ventricle. However these changes have a diffuse type, and it 
is not possible to make a more elaborate statement on a probable deviation, thereby 
full clinical diagnosis is necessary for this purpose. 

 The additional information represented by the black-and-white text, is 
not the DIAGNOSIS! It is the recommendatory information on the most probable 
pathological conditions which dispersive characteristics are similar to the 
dispersive characteristics of an analyzed electrocardiogram. Only full examination 
can confirm or specify additional text messages 

4.3.4 Viewing of the detailed elaboration  

If the indicator «Code of detailed elaboration» contains indexes of deviations 
(nonzero figures), or if you wish to view quantitative values of typical parameters of 

an input electrocardiogram, press  button – Detailing window. The window of 
detailed elaboration will appear on the screen. The text of the conclusion is repeated 
in the top part of this window for convenience, some standard parameters of the 
input ECG appear in the left part. A section with text messages on the probable 
pathological portraits which are the most similar to patient’s portrait and the 
indication of corresponding probable nosologic units appear in the right part of the 
window. In the top part of that section color code of the detailing is indexed.  

 
Color indication of detailing code 

Indicator color of a code shows a degree of similarity of dispersive 
characteristics of the heart of a patient with dispersive characteristics of the certain 
group of pathologies in accordance with the following table: 
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Code color of 
detailing 

Text of detailing Degree of similarity with a 
probable pathology 

Light green Probably: The portraits of a patient’s 
heart and a specified 
pathology are virtually 
congruous 

Average (gray-green) Possible:  Significant similarity of 
portraits 

Dark Uncertainty - specific 
peculiarities. The 
significant form of 
this deviation will be 
as follows: 

The portrait of the patient’s 
heart has many 
peculiarities. Exact 
congruence is not present, 
however it is very likely 
that the significant stages 
of the changes will become 
congruous with a specified 
pathology portrait  

Detailed elaboration is carried out on nine groups of automatic classifier: G1, 
… ,G9. This information allows for specification on additional reports of the general 
conclusion. For example, if in the additional information of the conclusion in the 
section entitled “VENTRICLS” appears a message on a probable ischemia of the 
myocardium and, at the same time, in the detailed elaboration in groups G3 … G7 
messages appear of ischemic onsets this clearly indicates a high probability that a 
full diagnostic examination will detect the ischemia.  

The automatic classifier of screening analyzer CardioDM-06 ® essentially 
differs from renowned computer interpreters in that it does not require lengthy and 
effortful reliability control of the ECG conclusion. The portrait is formed on 
objective dispersive signals irrespective of the conclusion; therefore a glance at 
the heart’s portrait is sufficient for purposes of reliability estimate. Deviations 
always give rise to changes on a green palette indicating a normal myocardium. 

4.4 Examination: record of the comments 

In the bottom part of a detailing window is the window of comments where a 
doctor can input through the keyboard any required information regarding the 

examination or his/her final conclusion. To input the text press the  button and 
proceed inputting the text in the new window that came up. For saving the text press 
the <ОК> button. In the printed version, doctor’s comments will appear on page 3 of 
the form. The free space of this page can further be used by the doctor for hand-
writing notes. 
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The window is used to write doctor's notes  

 
 
 

4.5 Examination: review of additional parameters of the input ECG 

If the doctor needs to assess some general features of RR intervals or 
amplitudes and the durations of the some ECG waves, she/he should review the table 
«Indicator Lead Data» (indicator lead in this program refers to the lead with the 
maximal amplitude of the R wave, i.e. the lead closest in direction to the electric axis 

of the heart). This table can be retrieved using button : 

 
The table which appears displays the results of automatic measurement of a 

number of amplitude and time quantitative features. These represent the average 
values determined on all PQRST-complexes of an ECG and which do not contain 
artifacts. The # symbol implies low reliability of the measurement (assessment is 
lacking). Abbreviation HRV means “heart rhythm variability”. 
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While calculating the average values on all analyzed PQRST-complexes, the 
representative complex is not singled out, therefore the interface does not contain 
representative complex with wave marking, traditional for the ECG-ANALYSIS. To 
increase the accuracy of interval duration monitoring, the automatic measurement is 
conducted on the enlarged scale of the ECG. Such measurement sometimes results in 
the 10...15% increase of the duration of an R wave with respect to the measurements 
conducted with a standard ECG of usual amplitude. This increase is conditioned by a 
more exact fixing of the beginning and termination points of the R wave on an 
enlarged scale. When required, the accuracy of the automatic measurements of 
amplitudes and intervals can be verified in a «manual mode» by utilizing ECG 
feature measurement window. 

If minimal or maximal boundaries of norm are present they are displayed in 
corresponding columns of the table “Indicator Lead Data”. To get a more detailed 
view of the ECG in large scale and to view additional measurement of intervals or 
amplitudes in any lead I … aVF, press the “Amplitude” button located at the bottom 
of the table. In the window that came up, namely “Average Wave Amplitudes in all 
Leads» choose the lead as required and press "ECG" button. The ECG feature 
measurement window will come up on the screen.  

4.6 Classification of deviations 

 

The window consists of nine deviation group. The code of each group 
corresponds to the number of the listed typical deviations. 
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4.7 Window of detailing 

 

The text of conclusion contains screening estimation as well as additional 
information about the expressiveness and the type of probable pathology to take 
subsequent decisions. Screening estimation differs from additional information 
by color: the text of screening estimation is colored while additional text is black 
and white. 

Additional information given in black and white is NOT DIAGNOSIS! It is 
recommendable information about probable pathological states, dispersive 
characteristics of which resemble dispersive characteristics of the ECG under 
analysis. Only complete examination can confirm or verify additional text messages. 

In the right part of the window there is a section of text messages about 
probable pathological portraits bearing most resemblance to each other with 
indication of corresponding nosologic units. The upper part of this section shows 
colors of detailing code. 
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4.8 Scanning ECG: 6 leads 

 

This window is used for a simultaneous view of the initial interval of all the 
leads. If cursor is matched with the line of any of the leads and the right mouse key 
will be pressed, a window of ECG measuring screening analyzer with corresponding 
ECG line will also appear. The initial point of the measuring screening analyzer will 
be set on a chosen ECG point. 

If the button (I, II, III, aVR, aVL, aVF) will be pressed, a window of ECG 
measuring screening analyzer with corresponding ECG line will also appear. The 
initial point of the measuring screening analyzer will be set on the beginning of ECG 
line.  

ECG fragments can be scrolled simultaneously with using scrolling in the 
button of the window. 
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4.9 Scanning ECG: 1 lead 

 

This window is used to perform the rhythm check-up in a convenient mode, 
since 30/60 sec ECG is presented in this format. If it is necessary to review some 
recording interval, set the mouse cursor on the required point of the ECG-line and 
press the right mouse key. A window of the ECG measuring screening analyzer will 
appear. The initial point of the measuring screening analyzer will be set on a chosen 
ECG point.  

The buttons switching of the ECG-leads are located on the right side of this 
window. 
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4.10 Scanning a portrait 

 

The indicator “Detailing” informs the doctor of possible pathological 

deviations. Their names can be scanned with the button  – Detailing of the 
button panel. Besides, these names can be seen without exit from the portrait 
window. For this purpose place the cursor on indicator “Detailing” (the cursor in this 
case does not change the pictogram) and press the left key of the mouse. The tag 
window “Deviations classification” will appear. The code of each group corresponds 
to the number of the listed typical deviations.  

There is located auxiliary graphical indicator on the left side from portraits 
where direction of electrical axis of the heart on frontal plane (QRS angle, some 
typical quantitative characteristics of waves and intervals of initial ECG are 
displayed.  
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4.11 ECG Feature Measurement Indicator 

 
ECG Feature Measurement Indicator 

This window has three functional modes: «measurement is switched off» 
(initial mode), «amplitude measurement» and « temporal measurement», assigned in 
Mode field by means of indicator setting in appropriate position (None, Amplitude or 
Time). 

First, in the initial mode «measurement is switched off» the user selects the 
required fragment of the ECG and convenient amplitude scale by scrolling on 
vertical and horizontal bars and utilizing "Amplitude" tuning option. If the signal has 
a lot of noise interference, it is advisable to turn on the "Filter" option by left-
clicking the mouse. It is important to note that amplitudes measured with the 
additional filtration option will appear to be 7% … 15% less than their true value.  

To measure the amplitudes, set the indicator to Amplitude by the left mouse 
click. Move the mouse cursor in the ECG field: a horizontal line of marker of the 
amplitude meter will appear. Set the marker in the position that you choose as a zero 
reference point, and press the left mouse key to fix a line of the point of origin. Then 
move the marker of the measuring screening analyzer till the required point on the 
ECG. Read the amplitude value in mille volt as related to the point of origin on the 
indicator “Amplitude” in the ECG field. If it is necessary to set a new zero reference 
point, move the marker to the desired value and press the left mouse key once again. 
In that way it is possible to measure the amplitude between the two selected points of 
ECG. 

To measure the interval size set the indicator to Time by the left mouse click. 
Move the mouse cursor in the field of ECG: a vertical line of the timing meter 
marker will appear. Set the marker in a position that you choose as a zero reference 
point for time, and press the left mouse key: a fixed line of the point of origin will 
appear. Next, move the marker till the required point on the time scale. Read data of 
the interval size in millisecond as related to the zero reference point in the indicator 
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“Time” in the ECG field. If it is necessary to set a new reference point, move the 
marker till the required value and press the left mouse key once again. In that way it 
is possible to measure the time between the time selected points of ECG. 

Both horizontal and vertical ECG scroll work in the measuring state. 

4.12 Tendency control: portrait gallery viewing  

CardioDM-06® offers unique possibilities of precise and fast control over 
the tendencies on the basis of viewing of the successively obtained portraits which 
are stored in the examination database. This allows to detect more precisely pre-
clinical forms of pathological changes and to monitor more effectively mild changes 
in the process of electric excitation of myocardium, that are not displayed on the 
ECG . For that a mode of portrait viewing on small scale is intended. 

Choose from list the desired patient from examination database and press the 

button . A scroll box of the portraits will appear on the screen. 

 
Selection of examinations for default view is set so that activation of view 

window will automatically cause portraits of last examination of the patient. You can 
find view control panel at the bottom of view window. You can choose view zoom – 
4 or 16 portraits and scroll list of portraits (i.e. list of examinations). The gallery of 

selected portraits can be printed out through the button . 
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When monitoring lists with great number of examinations it becomes 
necessary to select portraits from any part of this list, i.e. you should select portraits 
for manual view. In order to make such selection you should go back to main menu 

by clicking button  and use left mouse and Ctrl or Shift keyboard combination 
to generate necessary list. Ctrl+Left mouse combination allows selecting separate 
lines and Shift+Left mouse combination allows selecting of adjacent lines. After 

generating list click button  again. If generated list is more than size of portraits’ 
view window, use scrolling buttons. 

If you wish to enlarge separate portrait in order to view it in details just click 
left mouse on the same portrait. The window of enlarged portrait moves if you 
«drag» it by left mouse click on window headline. 

4.13 Input ECG viewing 

Buttons  and  are used to review the ECG. Button  is used to 
perform the rhythm check-up in a convenient mode, since 30/60 sec. – ECG is 
presented in this format.  

If it is necessary to review some recording interval, set the mouse cursor on 
the required point of the ECG-line and press the right mouse key. A window of the 
ECG meter window measuring screening analyzer will appear. The initial point of 
the measuring screening analyzer will be set on a chosen ECG point. The default 

case is that by pressing the button  an indicator lead will be displayed. 

The button  is used for simultaneously view of the initial interval of all 
the leads. If cursor is matched with the line of any of the leads and the right mouse 
key will be pressed, a window of ECG measuring screening analyzer with 
corresponding ECG line will also appear. 

4.14 Deletion of the examinations from database 

To delete the examinations data it is necessary to select the required line in 

the examination database and press button , which can be found in the key 
block “Examinations”. 

If you wish to delete several examinations then select lines for deletion by 
simultaneous left mouse click and Shift or Ctrl on keyboard.  

A local bin is provided as a means of erase interlock. All the deleted 

examinations stored in the bin . If you wish to restore some images, enter the 
bin, select them and press the restore button  
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 Be careful: by the deletion of the files from the bin the full list of files is 
deleted, that is why it is necessary to perform the restoration of the required files. 
The bin lists all deleted examinations only of the patient selected by you. It is 
recommended to clean the bins from time to time to prevent extra memory 
keeping. It is recommended to perform the cleaning of the local bin using the 
main menu function Clean selected bins and Clean all local bins. 

4.15 Deletion of the patients from database 
To delete patient from current database you should select required line in 

patient’s database and click button  located on «Patients» block of button panel. 
On default this function is locked. For the purpose to delete patient from database 
you can turn off this locking function by pressing Removal of the patient from 
Setting in main menu. 

Deletion of patient done will completely delete appropriate data without 
recycling it. In order to avoid mistaken delete, alert window for delete confirmation 
will pop-up. If you need to delete several patients at the same time, click left mouse 
and press Shift or Ctrl on keyboard simultaneously. 

 Pay attention: When you delete a patient, all his/her examination data 
deletes without restoration. There is no recycle bin for temporary storage of 
deleted patient’s data.  

Above-mentioned procedures are not convenient to repeat, if you need 
complete deletion separate database. To delete full list of patient enter into main 
menu section Filters and choose Select full list of patients option by left mouse 
click. Filters close, selecting list of «Patients» completely. Further, more click 

button  to delete selected list. After such operation, current database will be 
empty but it remains in list of databases and it can be used as a current database 
further more. 

If you need to delete database from list of databases follow below steps. 
Select List of databases option in Settings section of main menu. A List of 
databases window will appear where current database is selected by highlighted 
line. Select database for deletion by left mouse click and click Delete button. 
Warning message concerning lost of all data if deleted will appear. Upon 
confirmation of this message, selected local database will be deleted from database 
of screening analyzer. Current database can’t be deleted. If you need to delete 
current database you should first switch to another database. For this purpose locate 
mouse pointer on appropriate line and double click left mouse or click ОК button at 
the bottom of window. Such operation will switch from current database to another 
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one. Afterwards you should repeatedly activate «List of databases» window and 
delete the same database, which has no status currently. It is reasonable to delete 
stale databases after making preliminary achieve copy. 

4.16 Printing examination summary report 

The view of examination summary report can be changed. Function of 
summary report setting activates through main menu: Settings⇒ Type of form. 
Opened window displays options of page numbers of summary report, preview 
options (to printer/file) and summary report view options (complete/shortened).  

 

Complete report may contain 1, 2 or 3 pages. First page is obligatory, 2nd 
and 3rd pages can be deleted from report by user. To insert appropriate page in 
summary report you should switch on  selection indicator in opened window of 
«Type of form». Page 1 contains ECG/portraits, texts of screening-examination 
conclusion and list of main numerical ECG characteristics displayed on window of 
«Data of indicator lead». Text of main message of screening-examination conclusion 
is displayed by underlined font. Additional recommendations are displayed by italic 
font on page 1. Date and time of examination of summary report are displayed on 
headline of summary report form in square brackets. . Additional text messages of 
«General conclusion» and «Detailing» are displayed on page 2. Doctor’s 
recommendations typed on keyboard are displayed on page 3. In addition, there is 
empty space left on third page for doctor’s hand written prescription and advice. All 
three pages of summary report contain full copy of text messages of screening 
analyzer classifier. 
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Shortened report contain single page. Unlike complete report form shortened 
report form have no heart portraits and they replace by standard fragment of ECG for 
rhythm monitoring. 

Options of summary report view have two meanings: Print and File. If you 
choose File option a report directory will be called as disk file with .emf format. This 
vector format provides best display of summary report at any resolution of monitor 
screen or printer. User can edit name of created file. Default name of file is name of a 
current patient. File with such name will be saved as default in directory 
*:\CDM_EMF\ and <*> symbol refers to a disk space where CardioDM-06® 
program is installed. It is reasonable to create summary report in *.emf format while 
preparing illustration materials or sending summary report via internet.  

 The *.emf format files can be viewed and printed by any vector 
graphical editor such as CorelDRAW. Mostly available way of reading *.emf files 
is a widely spread word processor of Microsoft Word. To read *.emf files by 
Microsoft Word you should run Word and perform below steps: 

• Call out this function from main menu File⇒Page Setup. 
• Select <Orientation> bookmark in opened window and select <Landscape> 

option. If you need to print file you should also set up required margins 
settings. To get maximum viewable margin size of summary report you should 
fix “0” on all margins fields. 

• Go back to main menu and call out function from Insert⇒Picture⇒ From 
file. «Add file» in opened window using standard dialog box and indicate path 
to *.emf file and click OK. To view opened file without distortion set up 
suitable zoom of view.  

To print a summary report from Microsoft Word processor select function 
via File⇒ Print.  

Several seconds after clicking print button  formatted report form will 
be sent to printer (or *.emf file) and CardioDM-06® program ready to continue 
work («sand glass» busy indicator disappears). 

Printing time is determined only by processing speed of printer. If printer has 
low processing speed for printing image formats Windows system set a printing 
queue and slowly print out report forms performing other operations of CardioDM-
06® at the same time.  

At lower processing speed of printer, it is reasonable to print report forms at 
the end of working day as in this case you can set printing queue, which the 
computer does automatically. For this purpose: choose first examination for printing 

and click print button . In ~ 3 sec. sent to print process of report form will end 
(«sand glass» busy indicator disappears). Then, without waiting for printing process 
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termination you can choose next examination for printing and repeat above 
procedures, etc. Length of queue is limited by the computer performances. 

 For correct operation of report form creating function, at least installation 
of one printer in Windows operating system is compulsory. Installation of printer is 
performed via normal system function Start⇒ Settings⇒ Printers⇒ Setup 
printer.  

4.17 List of databases 

CardioDM-06® program has a list of databases where user can select 
current database necessary for operation. Mechanism of creation many databases 
makes it easy to operate this screening analyzer at a great flow of patients. It is also 
possible to create separate database for certain clinical departments and group of 
patients, etc. There can be 500 databases stored in one screening analyzer at the same 
time. Taking into consideration the feature of exporting data to archive this screening 
analyzer is the best solution for resolving any practical task. Database can be 
switched to current session through main menu via Settings⇒List of databases.  

Structure of List of database window is similar to that of List of doctors 
window. Default database list of patients supplied together with program contains 
one database: Database of Heart View. This database contains only demonstration 
section Samples. The default database can be renamed if necessary. For selection of 
current database from the list you should activate List of databases window via 
Settings⇒List of databases. 

 
Window « List of databases» 
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The third table column contains the information about total amount of the 
patients in the database (first number) and amount of examinations (second number). 

You should locate mouse pointer on required line and double click left 
mouse or press OK button on the bottom of window. The name of a current database 
displays on main window headline and headline of examination summary report after 
name of doctor. If you want to create a new database click Add button. Enter name 
of new database in the opened input window by keyboard. It does not recommend 
entering the name longer than 30 … 40 characters. This can also lead to incorrect 
text headlines. Name of database automatically displays as a short name of clinical 
department (firm) on the headline of examination summary report. Change and 
Remove buttons provided for editing database name and deleting database name 
from the list. Remove function used to complete deletion of local database from the 
list. The indicator of database arrangement is located over patient’s database 
window. 

4.18 List of doctors 

After running program the main window of the program will appear on 
screen and window showing «List of doctors». 

In order to start running program you should necessarily select name of 
the doctor. To select doctor’s name from list who will start current session of 
program you should locate mouse pointer on necessary line and double click left 
mouse or click OK at the bottom of window. The current name of the doctor is 
displayed on headline of main window and headline of examination summary report. 
If the doctor’s name is not included in the list you should enter new name by clicking 
Add button. It is not recommended to enter doctor’s name longer than 20 … 25 
characters. This can cause incorrect display of doctor’s name on window headline on 
the screen and examination summary report. 

 
Window «List of doctors» 
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Change and Remove buttons are provided for editing and deleting doctor’s 
name from the list. These operations are performed in a free running mode regardless 
your exit from «List of doctors» by clicking either OK or Cancel button. Current 
doctor’s name can be changed via function of main menu Settings and List of 
doctors without exiting program. The default list of doctors provided together with 
program contains only one name: Doctor. Allowable number of doctors’ names on 
the list is enough for practical operation of the screening analyzer: it is limited up to 
500 doctor’s name. 

4.19 Adjustment of indicators color  

User can change color of integral indicators of «Myocardium», «Pulse», 
«Rhythm» in the list of examinations. Standard resources of Windows-system can do 

it by clicking button .  

 

4.20 Export of examinations from database 

Examination export operation is necessary for three standard situations:  

1. To save selected examinations on a certain directory to send it further to 
another doctor by any storage screening analyzers, such as floppy disks, CDs or 
internet.  

2. To restore selected examination in another local database of the same screening 
analyzer.  

3. To create archive copies of local database on a specified directory.  

4.20.1 Export of data 

First operation, which has to be done before calling out <Export> function, 
is selection of exported patients. This operation done through main window in the 
same manner as deletion of patient’s list, i.e. simultaneous left mouse click and Shift 
or Ctrl buttons on keyboard. Such selection operation is necessary only when 
exporting small lists. If you wish to export all patients’ data of current database there 
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is no need to make preliminary selection of all list: this option clearly indicates in 
«Data export» window. 

Export of examinations performs by function of main menu 
Export/Import⇒Export. Submenu of this function contains two options: to 
directory and to database. 

• 

Selection of this option is necessary for normal case of export 1). For 
efficient classification of export procedures, CardioDM-06® program creates 
default directory *:\CDM_Export on root disk (disk where program installs). If 
necessary user can create another directory for export by system explorer (Explorer) 
or use any directory available on disk. After selection of to directory, option «Data 
export» window opens. 

Export to the directory 

 
Data export performs as follows:  

1. Choose directory for export through standard Windows function using Review 
button. It is recommended to use default directory *:\CDM_EXPORT which is 
displayed in Export directory field at the first call out of export function. 
Program saves last path to directory for export. 

2. Set amount of exported data by either selecting Export of the entire list or 
Export of the selected list option. In the latter case, do not forget to select 
appropriate list in patients’ database in advance.  

3. Set time interval you would like to use for export. If you need export all 
examination available on examination database select All option. To set time 
interval by date select Interval field by left mouse click and move mouse 
pointer to right to initial date indicator field and set required date. Date enters 
via keyboard or using calendar. To call out calendar click left mouse on 
calendar opening icon located at right side of entry field. Calendar window will 
appear on monitor screen.  

4. After selecting time interval, i.e. after going back to «Data export» window you 
have to make sure once again that correct export directory be selected and click 
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Execute button. If no examination is available, within indicated time-interval, a 
warning message 

 
In such case another time interval or All option in time settings to be selected. 
During export operation, a «sand glass» busy indicator will appear on monitor 
screen. Upon completion of export process, «Data export» does not close. For 
next export operation, it could be used again. If all export operation are 
performed click Cancel button to exit «Data export» function. 

5. Upon completion of export operation to directory a subdirectory creates as 
{Date_Time} where digital «Date» name will have YYYYMMDD format and 
«Time» name HHMMSS format. e.g. If data export was performed on August 
18, 2005 at 09:10:57 then there will be created subdirectory as 
{20050818_091057}.  

 
If necessary this name can be changed by Explorer. Such change will not 

lead to loss of information as export date and other working parameters duplicates in 
database. However, standard name {Date_Time} is more comfortable for visual view 
of directory when using next export operations. 

• 

Selection of this option is necessary if necessary to transfer data from one 
local database to another one. Export of data to another local database is performed 
in the same way as above described export procedure to directory. The only 
difference is that Review button selects one of the local databases available on this 
screening analyzer. Possible mistaken export of data to current database (i.e. 
incidental copy of data to the same directory) is blocked by pop-up message «This is 
current DB». Upon completion of export operation, new patients will appear in 
appropriate database. They can be visible after opening indicated database as current. 

Export to the database 
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4.20.2 Using data export to create archive  

It is reasonable to delete old examinations from working lists of local 
database. It relates with the fact that more examinations stored the lower 
performance of screening analyzer we have. Therefore, it is recommended to 
regularly export current databases to archive and clean working databases from old 
data after making back up archive copy. It is recommended to keep the databases of 
CardioDM-06® program in the following way. 

1. Create directory for saving archive on any available disk partition using 
Explorer, e.g. C:\CDM_Arc. It is possible to create several archive directories 
by certain calendar intervals, separate local database, etc. 

2. Make the required database current using function Settings⇒List of 
databases.  

3. Call out Export/import⇒Export⇒to directory function and export whole 
database to selected archive directory indicating Export of the entire list 
option in patients’ list and All in date list. 

4. After successful export delete all outdated records from current database and 
empty local recycle bins using function Recycle⇒Clean all local bins. When 
deleting examinations it recommends keeping only separate examinations just 
to monitor dynamics of disease during long period.  

Upon completion of above mentioned procedures a current copy of local 
database will be created as a subdirectory in selected archive directory 
…\{Date_Time} which can be viewed anytime by function Import from 
directory. 

 If archieve directories are copied on CD and later copied back on hard 
drive for review, in this case it is necessary before import operation to unmark 
<Read only> option for all files and folders on «Attributes» field using 
standard Explorer function (right click mouse, <Properties>). If this option is 
marked, import of such database will not be possible.  

4.20.3 The month calendar 

 



CardioDM-06 software for HeartVUE system 

63 

The month calendar control provides the user with a simple calendar 
interface, from which the user can select a date. The user can change the display by:  

• Scrolling backward and forward, from month to month. 
• Clicking the Today text to display the current day. 
• Picking a month or a year from a pop-up menu. 

4.21 Import of examinations to database  

CardioDM-06® program allows you to import examinations from databases 
created by export system. Examination import operation as well as export operation 
performs in three standard situations:  

1. To save current database of examination from other screening analyzer and 
further send it through storage screening analyzers (CD, internet).  

2. To review archive copies of local databases located on specified directory.  
3. To copy current database of examination from another local database of the 

same screening analyzer. This procedure is a mirror action as regards to export 
procedure of examinations from one local database to another one.  

Import operation performs by function of main menu 
Export/Import⇒Import. Submenu of this function contains two options: from the 
directory and from the database. 

4.21.1 Import of data  

• 

After selecting <from directory> option «Data import» window will appear. 

Import from directory 

 
Data import performs in the following manner: 

1. Click Review button and after appearance of «Choose directory» window 
specify directory-using standard Windows function wherefrom you would like 
to perform import. To enter any directory of Windows list double click left 
mouse on appropriate directory. CardioDM-06® program automatically 
analyses content of selected directory. If selected directory contains 
subdirectories in required format of databases, in this case, they are marked 
with blue «heart»  icon. If «heart» icon does not appear in selected 
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directory, it means that there is no any import data for import in this directory. 
Select appropriate directory for import, which has  icon. On the right side of 
window” Select directory” and operating information will be displayed in 
Comments field showing number of patients and date of creation of this 
directory. After confirming selection by clicking OK «Select directory» 
window will be closed and main import window appeared. Program 
automatically remember last selected path of import directory. 

 

If the option "Current database" is chosen, the selected patients and 
examinations will be copied in the current database. If the option "New 
database" is selected, the new database is formed which will be automatically 
included in the list of databases. 

2. After going back to «Data import» window click OK button. Window of 
import function settings will open. Set amount of data imports by either 
selecting Import of the entire list or Import of the selected list option. In the 
latter case, do not forget to select appropriate list on top of this window in 
advance using left mouse click and Shift or Ctrl on keyboard. 
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3. Set time interval that you would like to use for import. If you need to import all 
examinations available in examination database, select All option. To set time 
interval by date select Interval field by left mouse click. 

4. After selection of time interval, i.e. after going back to «Data import» window 
you have to make sure once again that correct export directory selected and 
click OK button. If no examination is available within indicated time interval, a 
warning message window will appear 

 
and import of «empty» patients’ list stops. In such case select another time 
interval or All option in time setting. During import operation, a «sand glass» 
busy indicator will appear on monitor screen. Imported list of patients opens in 
a current database only after exiting <Data import> function. A list of 
imported patients marked by a special symbol in <Surname> field in window of 
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patients’ database: “~” symbol attaches to last character of surname. It allows 
easily distinguishing main list from imported one.  

 There can be a situation where after import operation you cannot see in 
a current database window a patient selected in «Data import» window for 
importing. It is not an import operation mistake but automatic reaction of program 
on lack of examination form of that patient. If program found no data in 
examination form of that patient during data import operation analysis, in this 
case saving of «empty» patient’s data list to current database will be blocked. 

• 

Selection of this option is necessary to transfer data from one local database 
to another one. Import of data to another local database performs in the same way as 
above described import procedure from directory. The only difference is that Review 
button selects one of the local databases available on this screening analyzer. 
Possible mistaken data import from current database (i.e. incidental copy of data to 
the same database) is blocked by the pop-up message <This is current DB>. Upon 
completion of import operation, new patients will appear in appropriate database. 
There will be “~” symbol at the end of surnames of imported patients.  

Import from the database 

4.21.2 Running data import operation to view archive 

To view archive copy of local database it is reasonable to create new empty 
database in list of databases, e.g. name it as "Archive". Creation of new database is 
performed via main menu function Setting⇒List of databases by clicking Add 
button. After creation new database it should be selected as current and exit «List of 
databases» by clicking OK. 

Archive copy created by export function of this program has appearance of 
directory {Date_Time} located in archive directory, e.g. in directory C:\CDM_Arc\. 
To view this directory it is necessary to follow below steps:  

1. If archive directory {Date_Time} was stored on, CD and later copied back to 
archive directory C:\CDM_Arc\, in this case, it is necessary to unmark <Read 
only> option for all files and folders on «Attributes» field using Explorer.  

2. Choose function via Import/Export⇒Import⇒from directory. If archive has 
required format in this case name of archive directory {Data_Time} will be 
marked by  icon in «Select directory» window. Perform data import from 
…\CDM_Arc\ {Date Time}\ directory to current database created specially for 
viewing archive. If archive directory is not marked by  icon, it means that 
archive corrupted. Further use of this archive is not possible. 

Upon completion of archive operation, current database created for archive 
view can be deleted from list of databases. 
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 ATTENTION! 
If local databases have large capacity then import/export operations of 

appropriate lists may take several minutes even on fast response computers. 

4.22 Backup databases during operation 

Manufacturer guarantees uninterrupted and non-conflicting operation of 
CardioDM-06® program if serviceable computer and standard operating system are 
used. However there can be some cases of malfunction of CardioDM-06® program 
caused by failure of operating system (e.g. at emergency electricity shut down) or 
mistaken action in a root directory of program by unskillful user. If you face 
emergency related with malfunction of program while entering ECG or portrait 
creation, it recommends using Db2crasharc.exe utility. 

To run Db2crasharc.exe utility you should do the following steps: 
• Exit CardioDM-06® program if it is still running. 
• Enter root directory of CardioDM-06® program using Explorer. Root 

directory always has an appearance as …\CDM, i.e. same path as given for 
installation (e.g. if program is installed on default directory C:\Program 
Files\ in this case root directory will be C:\Program Files\CDM). 

• Select Db2crasharc.exe in root directory and run it by double left mouse click. 

Db2crasharc.exe program requires directory for «emergency» save of 
current database. Select directory and click OK button. As a result «emergency» 
archive including subdirectory as {Name of local database} creates in selected 
directory. Abbreviation of «Name of local database» is exact copy of name from list 
of local databases. If command windows appeared corrupted at «emergency» backup 
this utility replace them by indexed command names. Number of subdirectories 
created by Db2crasharc.exe will be equal to number of local databases. 

 
Furthermore deinstallation of CardioDM-06® program performs. 

Uninstallation can be done via Start⇒Setting⇒Control panel⇒Installation and 
removal of program or Start⇒Programs⇒CDM-06⇒Uninstall. Reinstall 
CardioDM-06®. 

After reinstallation, it is necessary to recover current database. For this 
purpose do the following:  
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• Create new local database and make it current and import first local 
database from «emergency» backup directory indicated in list of import 
directory. 

• Repeat described steps for number of recoverable local databases. 

Upon completion of importing all local databases, «emergency» archive can 
be deleted from drive space. 
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5. Annex I 

5.1 Examples of heart portraitures with different pathologies 

The first indicator in captions under the portraitures is a «Myocardium» 
indicator. The text corresponds to the verified clinical diagnosis (not to ECG 
decision). 

 
Normal Normal 

 
Normal Normal 

 
Ischemia, OMICS Valvular heart disease, LVH 

 
IHD, OMICS, Atrial fibrillation, AH, 

Recurent MI AH, Mild of LVH 
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The combined heart disease, Atrial 

fibrillation, Metabolic disorders Acute MI, HK of back wall 

 
Asymmetrical HCMP, LBBB AH, Hypokaliemia 

 
IHD, OMICS IHD, OMICS 

 
IHD, OMICS IHD, OMICS 

 
IHD, OMICS, Stenocardia, 1 year after 

ACG IHD, OMICS, 7 years after MI 
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IHD, OMICS, Diabetes mellitus IHD, OMICS, LVH 
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6. Annex II 

6.1 Peculiarities of clinical interpreting of heart portrait 

This screening-screening analyzer monitors repetitions of the 
characteristics of low-amplitude oscillations of ECG-SIGNAL unavoidably 
generated at each heart beat. The amplitudes of these oscillations (dispersion of 
oscillations) do not exceed 0.01 ... 0.03 mV, i.e. in tens of times less amplitudes than 
ECG waves. The term “dispersion”, which is assigned to a used method of the 
analysis, corresponds to the definition generally accepted in cardiology as a 
difference between the greatest and least values of the varying value. To observe and 
to measure the characteristics of such random oscillations, it is necessary to 
superimpose signals of one-type ECG waves, i.e. synchronize a beginning of 
electrical excitation of several sequential waves. The examples of such low-
amplitude oscillations of QRST complex in one lead are represented on fig. 1 and 
fig. 2. In fig. 1 the low-amplitude of oscillation of a healthy person ECG is 
represented, in fig. 2 – same in case of a subacute stage of MI. Some amplitude and 
frequency peculiarities of oscillations changes are visible in these cases. 

 
Fig. 1. Low-amplitude oscillation of ECG in sequential QRST-complexes of healthy heart. 

a) separate complex; b) 7 sequential synchronized complexes 
 

 
Fig. 2. Low-amplitude oscillation of ECG in sequential QRST-complexes for MI 

 
The especially important information contained in oscillations of fronts of 

sequential analyzed waves is not visible on a usual ECG. 
Experimentally shown these hidden "dispersive" features despite the low values 

of analyzed differences of amplitudes of ECG-SIGNAL with particular mathematical 
processing will form steady groups – dispersive clusters in new space of small 
fluctuations of ECG. The dispersive clusters have appeared to be effective markers of 
micro changes of electrical activity in the myocardium. The physical basis of 
creation of dispersive clusters is made by a continuous control of potential 
differences measured in two close points in certain areas on the body surface at 
depolarization – repolarization of myocardium. For augmentation of classification 
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stability of dispersive clusters such control is made for many pairs of closed points. 
Potentials of some points, which are necessary for the analysis, but which are not 
measured directly, are defined on the basis of special calculation. The dispersive 
characteristics, Due to the significant nonlinearity of depolarization – repolarization 
processes of myocardium, at origin of abnormalities from norm start to vary earlier 
than it appears on a usual ECG. For this reason the given screening analyzer can 
react on hidden or preclinical forms of myocardium changes. Thus, the dispersive 
characteristics in most cases do not duplicate the common ECG analysis but give 
new specific information about myocardium. 

These methodical peculiarities generate appropriate features of clinical 
interpreting of heart portraits and text conclusions. These features are formulated in 
the following references, which it is necessary to be guided in practical operation 
with this screening analyzer. 
 
N  The screening-

conclusion  The comments and references 

1. General conclusion  

1.1  The indicator 
"«Myocardium" – 
0 … 14%  

This conclusion is arrived at when the dispersive 
characteristics are within normal parameters. If in other text 
reports, including groups G1 … G9, there are no 
indications on possible hypoxia or other changes, it is 
feature of physiological norm. Thus the heart portrait has 
solid green color and the text contains the following 
conclusion:” No significant DISPERSIVE abnormalities 
from norm. This conclusion CAN be used only by 
comparison to history and physical data. If the patient takes 
medicines, this conclusion requires obligatory précising 
based on complete examination and dynamics control with 
the help of the given screening analyzer. 

However, the dispersive characteristics approximately in 
5 … 7% of cases can be normal at presence of a pathology 
in history. A main reason of such cases is the current 
effective medicinal therapy. If a dosage and composition of 
medication are optimally selected, the electrical stability of 
myocardium in rest can become enough high, that leads to 
essential decrease of dispersive abnormalities. 

For this reason in case of medicamental treatment the 
given screening analyzer can be used only for monitoring 
heart state dynamics and efficiency of medicinal therapy. If 
the indicator "Myocardium" changes in sequential tests and 
exceeds 14% or there is other clinical basis for an 
improvement of the conclusion - it is necessary to take 
additional recommendations of table A2 of the given 
manual on carrying out of examination at a minimum load. 
The simplest way of such additional examination is 
orthostatic test. For the healthy patient at this test the 
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N  The screening-
conclusion  The comments and references 

dispersive characteristics do not vary or are worsened very 
insignificantly ("Myocardium" no more than 15%). Thus, the 
homing of heart portrait to the initial state on the average 
does not exceed 4 min. Opposite to this, for diseased 
patients the considerable augmentation of dispersive 
abnormalities and slow homing to the initial state exceeding 
4 min. are observed. 

In the given category of abnormalities opposite situation 
also is possible, when the value of the indicator 
"Myocardium" does not exceed 14%, but the changes are 
visible on a heart portrait. If the additional test according to 
tab. A2 confirms norm, this situation corresponds to 
individual peculiarities of myocardium. More often reason of 
such peculiarities is the small abnormalities of an electrical 
symmetry of leads, which is the testimony of compensatory 
changes in one of ventricles (more often in left) and can be 
inherent or acquired. In such situation the observation of 
dynamics is expedient, since such changes can be a 
precursory manifestation of starting development of 
pathology. 

At comparison of the text conclusion and portrait always it 
is necessary to remember that in the given screening 
analyzer automatic screening conclusion and heart portrait 
are shaped independently to increase conclusion reliability. 
The heart portrait gives more precise information on 
presence of even inappreciable dispersive abnormalities. 
Simultaneously the digital indicator "Myocardium" gives 
more rough current estimation of a clinical significance of 
these abnormalities. Therefore, presence of changes on a 
portrait at the “Myocardium" value less than 10 … 12% 
means, that the probability of pathological manifestations of 
these changes is insignificant.   

1.2  The indicator 
"Myocardium" – 
15 … 22%. 

The given category of abnormalities corresponds to a case 
of border-line states. If necessary to improve of the 
conclusion, take the references of tab. A2 (item 6.2) on 
additional test with a small load. 

1.3 Indicator 
"Myocardium" – 
23 … 100% 

Authentic dispersive abnormalities. For given category of 
abnormalities the complete examination for diagnosis and 
observation of portrait dynamics are necessary 
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N  The screening-
conclusion  The comments and references 

2. Rhythm 

2.1 The most 
probable reason 
of the enlarged 
indicator 
"Rhythm" is 
increased level 
of stress. 

The given abnormalities testify to enlarged rhythm 
variability. If this report is steadily observed during some 
hours or periodically repeated within several days at value 
of the  

"Rhythm" indicator more than 60%, the examination for 
clearing up of stress reason is necessary. 

2.2 There are 
manifestations of 
abnormalities of 
generation or 
conduction of 
excitation. 

These deviations are always accompanied with the 
recommendation to analyze data of indicator lead. The data 
of the rhythm characteristics are shown in the left lower 
table of the indicator lead window. The more exceeding 
above acceptable limits of values RRmax/RRaverage, 
RRmin/RRaverage and the more indexes of relative 
lengthened and shortened RR, the more significant 
abnormalities of cardiac rhythm. These abnormalities have 
the changed color on the data table. The special attention 
is necessary on increased rigidity of rhythm, which is 
additionally indexed on an index « HRV Abnormalities». At 
enlarged rigidity the index RRmax/RRaverage is much less 
than a low border 1.04, and simultaneously the index 
RRmin/RRaverage is more than a high border 0.95. 

The considerable abnormalities of rhythm, especially at 
presence intraventricles blockades, can be accompanied 
with extrasystoles. 

The arrhythmias are always accompanied with dispersive 
abnormalities either in atriums, or in ventricles, or in all 
chambers of heart. The monitoring of dispersive 
abnormalities in the given screening analyzer is a main 
source of information about state of myocardium, and 
estimation of rhythm variability is auxiliary. Therefore, the 
observation of dynamics of dispersive heart portraits in 
such cases allows qualitatively to judge about probability of 
electrical instability of heart. 

Due to auxiliary character of the analysis of rhythm, the 
automatic classifier of extrasystoles working only on 
indicator lead has a hyposensitivity ~ 90%. Therefore, for 
the target analysis of extrasystoles 
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N  The screening-
conclusion  The comments and references 

3. Electrical axis 

3.1  In the given screening analyzer the direction of heart 
electrical axis is defined by QRS angle, which is calculated 
on a gradient of electric potential. The exceeding of value 
of QRS angle above limits -15 …. +90 degrees is always 
connected to presence of dispersive changes. This feature 
has no independent value for dispersive analysis. In the 
screening analyzer interface it is only intended for informing 
about the value of feature generally accepted in the ECG-
analysis 

3.2  If measured QRS angle is more to the right +130 degrees 
(on standard 6-axial coordinate system) or more to the left -
120 degrees, in most cases it is connected to dextrocardia. 
In such situation the doctor has to clarify the heart position 
in a chest by the generally accepted ways and if 
dextrocardia is confirmed to repeat examination with the 
changed position of electrodes R, L. 

4. Myocardium of atriums 

4.1 Changes of 
atriums 
depolarization. 

In the given screening analyzer classification sensitivity, i.e. 
the sensitivity of the text reports concerning changes of 
atriums myocardium is diminished. It is connected to that 
the dispersive clusters of atriums at monitoring only limb 
leads have less stability than dispersive clusters of 
ventricles. However on heart portrait the visual sensitivity is 
saved on initial state. It allows a doctor precisely monitor 
the changes dynamics for screening tasks. 

5. Myocardium of ventricles 

5.1 Manifestations of 
hypoxia or 
ischemia of 
myocardium 

The ECG dispersions indirectly reflect current changes of 
the electrical characteristics of ionic canals of cardiac 
myocytes. These changes can have steady or temporary, 
transient character. For this reason, it is impossible to 
distinguish transient hypoxia from ischemia of myocardium 
at small dispersive abnormalities. In case of significant 
hypoxia manifestations in the dispersive characteristics 
ischemia has high probability and the specificity concerning 
ischemia of myocardium is ~ 75%. The remaining 25% 
cases of major abnormalities are stipulated for heart-
defects, cardiomyopathies and some other pathological 
changes of myocardium.  

Such decreased specificity to ischemia is reasonable for 
screening analyzer, as its intention is well-timed to reveal 
the fact of developing pathology, but not its type. Thus at 
detection of significant changes, which are referred to 
probably ischemic by the screening-screening analyzer, 
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N  The screening-
conclusion  The comments and references 

approximately 25% of them will be not ischemic origin. 
However, in all such cases the fact of presence of 
significant abnormalities which require verification is 
absolutely authentic. The clinical diagnosis can be only 
made with complete examination of a patient, for which the 
screening analyzer has revealed significant abnormalities 
from norm. 

The sensitivity to ischemia of myocardium with 
recommendations of the table A2 on additional testing of 
“border” group is ~ 80%. Approximately in 20% cases at 
some forms of ischemia the screening analyzer does not 
reveal abnormalities or reveal them not significant 
(indicator “Myocardium” less than 16%). This effect is 
characteristic for two practically important cases: at first, for 
back localization of ischemic changes with shift to basal 
departments; secondly, for intensive medicamental 
treatment. If in these cases there are clinical basis for more 
detailed analysis, it is necessary to take the 
recommendations of the table A2 (pulse augmentation on 
15 … 25% or orthostatic test). Such additional testing with 
load, which is much lower submaximal, considerably raises 
screening analyzer sensitivity in such situations. Due to 
relative rarity of such events and fast examination 
procedure the additional testing practically has no effect for 
average time of examination which is not exceeding 4 min. 

6. Symmetry of leads 

6.1 Asymmetry of 
ventricles 
depolarization in 
comparison with 
norm. 

This specific for dispersive analysis feature gives the 
important additional information about abnormalities of 
amplitude and temporal relations in electrical excitation of 
the right and left ventricles. In norm the dispersive 
characteristics of leads, symmetric of QRS angle, are 
identical. Any asymmetry of these characteristics testifies 
to electrophysiological changes of normal excitation of 
myocardium. Screening sensitivity of these changes is very 
high, ~ 90%. At the same time clinical specificity is 
insignificant, i.e. it is impossible to reliably classify a 
genesis of the detected changes in the given screening 
analyzer. The common dependence is those: if the 
deviations are significant and simultaneously present in 
detailing group G9, there is high probability it is connected 
with diagnosed hypertrophy of one of ventricles, or 
preclinical stages of hypertrophy, or compensatory 
dilatation of one of ventricles. If dispersive deviations are 
small or moderate, it is a testimony of constant 
compensatory reaction, as a rule, of left ventricle. A reason 
of such reaction can be inherent peculiarities of 
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N  The screening-
conclusion  The comments and references 

myocardium or heart valves. Besides such reaction can be 
observed at acute ischemia, when regulatory mechanisms 
try to save a reasonable level of cardiac ejection in 
conditions of partial injury of myocardium. 

If in the rest parts of “General conclusion” and the 
“Detailing” significant changes are not present, but they are 
present in group “Symmetry of leads”, the dynamics 
monitoring is necessary. The steady character of such 
changes can be an indicator of initial dilatation changes, 
which are not yet visible with echocardiogram (EchoCG). 
The instability of this feature at dynamics monitoring can 
testify to periodic oscillations of myocardium metabolism. 

7. Other changes 

7.1 Manifestations of 
increased stress 
- reaction of an 
organism. 

The given manifestation reflects common changes of 
indicators of rhythm variability and P-Q, Q-T intervals. 

This message is auxiliary and testifies to high tension of all 
links of heart rhythm control. Constancy of this message 
can be manifestation of approaching failure of adaptation. 
Such situation is typical either for the significant stress, or 
for compensatory reactions in case of myocardium 
damage. 

The screening-screening analyzer does not make a diagnosis, but points out the 
likeness of dispersive characteristics of patient ECG at the examination moment and 
the dispersive characteristics of standard ECG of some clinically significant 
pathologies. For this reason the interpreting clinical significance of certain 
examination results should be based on synthesis of all three output components of 
the screening analyzer: a portrait, “Conclusion” and “Detailing” (item 4.4). The 
advisable order of such synthesis for probable ischemic manifestations is represented 
on the table A2 of the given appendix. 

At dynamics monitoring dispersive deviations is divided in three groups of stability: 
Stable: The deviations of the indicator “Myocardium” in 

sequential examinations do not exceed ~ 3 … 7%. 
Moderate deviations: The deviations of the indicator “Myocardium” in 

sequential examinations are ~ 8 … 10%. 
Significant deviations: The deviations of the indicator “Myocardium” in 

sequential examinations exceed 10%.  

If in the “General conclusion” or in the section “Myocardium of ventricles” 
suspicion on hypoxia or ischemic changes appears, it does not yet testify to ischemic 
illness of heart. Due to high sensitivity the screening analyzer responds to both on 
clinically significant forms of ischemia, and short episodes of transient ischemia or 
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hypoxia, which can not relate to coronary pathogenesis. In such cases it is the 
information that the dispersive characteristics of myocardium at the examination 
moment have deviated from norm to the characteristics of ischemic states. The 
clinical significance of such message depends on, whether it is approved by heart 
portrait and detailing information, and also high recurrence of such messages. The 
more references to hypoxia in detailing groups G3 … G7, and the more changes on a 
portrait, the higher probability of clinical form of ischemia (table A2). But in any 
case, the screening analyzer indication of ischemic changes when other clinical 
manifestations of ischemia absence, testifies authentically to presence significant 
subliminal deviations, which should been periodically monitored with dynamics of 
heart portrait, and which can reveal in clinical forms at unfavorable circumstances. 

6.2 Features of heart portrait  

The heart portrait in the given screening analyzer is only intended for screening 
tasks; therefore on quasiepicard surface of 3D-model of heart the most important 
information about dispersive changes both for the depolarization, and repolarization 
of myocardium is simultaneously displayed. Such artificial association of 
depolarization and repolarization processes in one portrait enlarges efficiency of 
visual review and simplifies dynamics monitoring of dispersive changes. At review 
of portraits it is necessary to remember some methodical limitations described in the 
following comments. 

 
Area of visual 

changes  The comments and references 
1. Atriums  
 Depolarization 

 

When P wave amplitude decreases or changes, 
colour of atriums varies from green to brown. 
When electrical activity increases, colour of 
appropriate atrium becomes blue, and at the 
significant hypertrophy - violet.  

2. Ventricles  
Depolarization 

 

These areas on a portrait reflect dispersive 
changes in a final stage of depolarization, which 
are most informative when myocardium hypoxia is 
monitored. The greatest correlation with hypoxia 
has a reddening of this area in the left departments 
of heart.  

Repolarization 

 

The topological resolution ability of repolarization 
dispersions is a little reduced at monitoring of 
areas close to intraventricular septum. For this 
reason in some cases red changes on ventricles 
border cover the whole right ventricle, though the 
functional or morphological changes occupy only 
small part of myocardium near projections of 
intraventricular septum. This topological 
inaccuracy of the given screening analyzer is 
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Area of visual 
changes  The comments and references 

irremovable. However it does not influence on 
screening sensitivity and possibility of precise 
dynamics monitoring. 

3. Duration of processes of electrical excitation  
 P-Q interval  

 

The redder colour this area has, the more 
elongation of P-Q interval. When duration of P-Q 
interval decreases, colour varies to blue. 

 Q-T interval  

 

This area colour characterizes average deviations 
from the empirical standards based on the Bazett’s 
formula. The red colour corresponds to elongation 
of Q-T interval.  

QRS duration  

 

This area colour correlates with QRS duration. 
Green colour corresponds to norm. 

6.3 The clinical significance of ischemic manifestations in the border-line 
group 

The given table contains the description of the four typical situations, which 
occur during the analysis of messages received from the auto-classifier of the 
screening-screening analyzer in so called border-line group conclusions. This group 
includes the patient’s myocardium states, which either are connected with the stable 
pathology or with transient changes in myocardium, caused by some functional, 
metabolic and other reasons of the transient nature. To this group the value of the 
integral indicator is in the range 10… 23% as a rule. Each situation in the table is 
described by three lines. The first line “Deviations” includes the description of the 
deviations and changes, related to the obtained image and conclusion for 
myocardium of heart ventricles. The second line “Recommended actions” gives the 
recommendations how to get additional heart portraits that are helpful for making 
more accurate conclusion. The third line “Synthesis” includes the recommendation 
for the final interpretation of the clinical significance of the obtained screening 
conclusion. The recommendations stated in the table are advisable to be used in those 
cases when the anamnestic data and the physical examination data do not correspond 
to the obtained screening-conclusion of this medical screening analyzer, or when 
there are other clinical reasons to specify to make the screening-conclusion more 
accurate. 
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 If, during the application of the recommendations, given in the table, the 
doctor obtains the conclusion about probable ischemia, it is recommended to pay 
attention to the textual message for the groups G3,G4 and the color of the region 
15 on the heart portrait. If there are no significant pathological changes in the 
groups G3,G4, or the region 15 is green-stained – IHD (ischemic heart 
disease) is an unlikely conclusion. Such cases, as a rule, correspond to the 
pathological changes of another genesis, which cannot be detected in the 
conclusions presented by this medical screening analyzer. (These are mainly 
cardiomyopathies, myocarditis and some heart defects)  
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7. Annex III 

7.1 Criteria of Comparison of Dispersive Deviations and Generally 
Accepted ECG Diagnose 

The present Attachment contains the table of comparison of relevant 
dispersive characteristics of low amplitude ECG fluctuations used in screening –
 screening analyzer, and generally accepted criteria of ECG conclusions in 
registration of resting ECG 

 

from limbs. The given comparative table established the 
relation between the additional text conclusions of screening analyzer and generally 
accepted methodical recommendations for ECG analysis used by physician in 
practical work. Dispersive deviations in many cases reflect the processes of early 
stages of changes that have no direct analogues amid the criteria of ECG opinions 
used in practice. For that reason several “dispersive” conclusions reflecting early 
stages that haven’t yet reached clinical stages may correlate to one generally 
accepted criteria of ECG analysis describing clinical stages of pathological changes. 
For the same reasons the given list of generally accepted criteria of ECG conclusions 
is not complete: it is given solely for the purpose of simplifying clinical 
interpretation of additional texts of screening conclusions at the first stages of 
working with screening analyzer. And finally, the given comparisons may be neither 
absolutely precise not categorical as the “dispersive” conclusions of screening-
screening analyzer are not diagnostic, and the given comparison always has certain 
borders of probability. Such “tolerance” of comparisons is inevitable as analogues of 
many dispersive deviations due to high sensitivity of the latter may be seen only on 
standard ECG from 12 leads, and some deviations – only on ECG with physical 
activity. 



CardioDM-06 software for HeartVUE system 

85 

Table A3. Correlation of Dispersive Deviation with Standard Electrocardiographic Diagnoses 

Screening conclusions on 
dispersive deviations of low-

amplitude fluctuations 

ECG conclusions appropriate to 
the dispersive deviations 

1. General conclusion 

Significant deviations are NOT 
DETECTED. This conclusion is 
ALLOWED ONLY in comparison with 
additional clinical evidence. If patient 
takes MEDICINE this conclusion shall be 
exacted on base of the complete clinical 
examination. 

ECG is OK  

Little DEVIATIONS WITHIN THE NORM 
LIMITS: It’s wise to observe DYNAMICS 
to correct the normal due to initial phase 
of the significant deviations. 
Little DEVIATIONS of ventricular 
excitation: it’s wise to observe 
DYNAMICS, as these deviations are 
either beginning of the significant ones or 
sign of temporary functional instability. 
Mild signs of left ventricular abnormalities 
are possible. 

ECG is OK (deviations are not appeared 
at the rest ECG) 

Little changes of ventricular myocardium. 
It’s wise to observe DYNAMICS 
Signs of left ventricular abnormalities are 
possible. 

Intermediate ECG (between norm and 
pathology) is possible. 

DEVIATIONS – refer to probable detailing 
in deviation groups. 
SIGNIFICANT DEVIATIONS: Pathologic 
deviations are possible. Refer to probable 
detailing in deviation groups. 

ECG is pathologic 

Q–T interval prolongation. 
SIGNIFICANT PROLONGATION of Q–T. 

Q–T interval prolongation from the norm 
at specified heart rate. Q–T is longer 
than 0.44 s. 

2. Rhythm 
Sinus rhythm is NORMAL. Rhythm at heart rate of 60 to 80 per 

minute in cardiac pacer. P-waves are 
positive in leads I, II, aVF and negative in 
aVR lead.  

Pulse is NORMAL but rhythm is deviated 
from the NORMAL one. 

Rhythm at heart rate of 60 to 80 per 
minute with some P-waves missing or 
little deviations of rhythm variability.  
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Moderate TACHYCARDIA. Rhythm at heart rate of between 80 and 
110 per minute  

Significant TACHYCARDIA. Rhythm at heart rate of higher than 110 
per minute  

Moderate BRADYCARDIA. Rhythm at heart rate of lower than 60 per 
minute  

Significant BRADYCARDIA. Rhythm at heart rate of lower than 50 per 
minute  

High rhythm is caused by high STRESS: 
Significant arrhythmia is NOT detected. 

Observed ECG section has sinus rhythm 
but parameters of rhythm variability and 
the intervals are slightly beyond the norm 
limits. 

Integral rhythm is high. Little signs of 
arrhythmia. HIGH STRESS is the most 
probable cause. 

Significant deviations of sinus rhythm are 
not appeared but parameters of rhythm 
variability and the intervals are far 
beyond the norm limits. 

Deviations from the norm rhythm 
variability are possible. 

Parameters of rhythm variability and the 
intervals are not far beyond the norm 
limits. Abnormality due to sinoatrial or 
AB-junction blocks are possible. 

There are signs of abnormality of 
excitation and conduction processes. 

A type of arrhythmia. Parameters of 
rhythm variability and the intervals are far 
beyond the norm limits. 

Significant ARRHYTHMIA. Parameters of rhythm variability and the 
intervals are far beyond the norm limits. 
Significant missing of ventricular 
complexes. A type of tachyarrythmia or 
bradyarrhythmia. 

3. Electric Axis 
Electric axis deviation to the LEFT. Electric axis position is to the left of -15°. 
Electric axis position is HORIZONTAL. Electric axis position is between +30° and 

-15°. 
Electric axis position is NORMAL. Electric axis position is between +75° and 

+30°. 
Electric axis position is VERTICAL. Electric axis position is between +90° and 

+75°. 
Deviation of heart electrical axis to the 
RIGHT. 

Electric axis position is to the right of 
+90°. 

DEXTROCARDIA is possible. Electric axis position is to the right of 
+130° or to the left of -120°. 

4. Atrium myocardium (plus P-Q changes) 
Atrial FIBRILLATION is possible. Irregular low-amplitude waves instead of 

P-waves. 
Atrial FLUTTER is possible. Higher frequency saw-tooth P-waves. 
Atrial FIBRILLATION↔FLUTTER 
exchange is possible. 

Saw-tooth P-waves intermittent with 
irregular or missed P-waves. 
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Pacemaker MIGRATION is possible. Variation of form and amplitude of P-
waves. If P-waves are inverted in leads I 
and II then pacemaker migrates to AB-
junction. 

Abnormal atrial depolarization is possible. Unstable form and low amplitude of P-
waves. 

Typical changes of atrial repolarization 
with possible ischemic changes of the left 
ventricular. 

PQ-line and ST-line depression like 
concave parabola near R-wave. 
Slantwise ST-upline with possible little 
depression at J-point. 

Signs of the left atrium enlargement. The 
left atrium hypertrophy is possible. 

P-wave is longer than 120 ms. P-wave 
direction on the front plane is to the left of 
+60°. So maximum amplitude of P-wave 
is shifted to I and aVL leads. 

Signs of the right atrium enlargement. P-wave amplitude is higher than 2.5 mm 
(0.25 mV). P-wave direction on the front 
plane is to the right of +60°. So maximum 
amplitude of P-wave is shifted to aVF, III 
leads. 

P-Q ENLARGEMENT. Take note to 
dynamics. 
 
P-Q interval is SHORTER. 

PQ is longer than the norm. Norm: 200 
ms at heart rate of 40 ... 50 per minute, 
120 ms at heart rate of 130 ... 160. 
PQ is shorter than 120 ms. 

5. Ventricular myocardium 
Ventricular myocardium changes like 
ischemic ones. It’s wise to take note of 
DYNAMICS and examine completely. 

Moderate depression or elevation of ST, 
lower amplitude and T-wave deformation. 

ABNORMAL QRS prolongation! Signs of 
MYOCARDIUM injury are possible. 
Examination shall be complete.  

SIGNIFICANT ISCHEMIC changes of 
ventricular myocardium are possible. 
Examination SHALL be complete. If 
these signs for this patient were not 
observed before but are repeated in 
stable manner now then emergency 
complete examination is needed.  

SIGNIFICANT ISCHEMIC changes of 
ventricular myocardium are possible. 
Complete examination is NEEDED. 
Correlation of these signs with cicatrical 
changes is possible. If these signs for this 
patient were not observed before but are 
repeated in stable manner now then 
immediate complete examination is 
needed.  

ISCHEMIC changes of ventricular 
myocardium are possible. Complete 

Significant elevation of ST at J-point at 
one or several leads. Simultaneous ST 
depression at other leads. 

Abnormal Q-waves of 40 ms long and 
25% of R-wave amplitude at the same 
lead. 

Deep negative T-waves with ST 
depression. 

Simultaneous depressions of parabolic 
PR and ST or Significant slantwise 
downward ST depression. 
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examination is NEEDED. Correlation of 
these signs with myocardium FOCAL 
CHANGES is possible.  

ISCHEMIC changes of ventricular 
myocardium are possible. Take note of 
this sign repetition. Myocardium FOCAL 
CHANGES or temporary myocardial 
ischemia is possible.  

ISCHEMIC changes of ventricular 
myocardium are possible. Complete 
examination is NEEDED.  
IT’S WISE to observe DYNAMICS, as 
NORM BORDER CHANGES may be the 
beginning of ischemic changes of 
myocardium.  

CHANGES of ventricular depolarization: 
it’s wise to examine completely as 
correlation of these changes with 
coronary ones is possible.  

There are little changes of ventricular 
repolarization. It’s needed to observe 
DYNAMICS: these deviations are either 
BEGINNING OF THE SIGNIFICANT 
CHANGES or sign of temporary 
functional instability.  

Nonspecific moderate local ST 
depression at some leads. Lower 
amplitude and T-wave deformation. In 
some cases significant deviations in the 
standard ECG are absent. 

MODERATE QRS prolongation.  

SIGNIFICANT QRS prolongation is a 
sign of interventricular heart block.  

QRS is from 105 to 115 ms.  

QRS is longer than 115 ms. Wide S-
waves in I, aVL leads (block of the right 
bundle branch). qR complex in I, aVL 
leads; rS complex in II, aVF; deformed R-
waves (block of the left bundle branch). 
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